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Revised: January 12, 2024

Introduction

This guide explains each xml tag used in the configuration file (. xm1) of Cisco IP DECT 6800 Series . Each tag represents a parameter
in the phone.

Each xml tag definition includes details such as command syntax, default value, and description.

New and Changed Information

Revision History

Release What's New and Updated

Firmware Release 5.1(2) Cfg_Rep_OnChange, on page 28
Cfg_Rep_Period, on page 28
Firewall, on page 60

Firewall Config, on page 60
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Release

What's New and Updated

Firmware Release 5.1(1)
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Release

What's New and Updated

PRT http header, on page 104

PRT http header value, on page 104
PRT upload_filename, on page 105

PRT upload_server, on page 105

Hebu Mode, on page 67

Subscr Hebu Password n , on page 144
Subscr Hebu Username n , on page 144
Language Rule, on page 72

Held Company Id, on page 67

Held Token Srvn, on page 68

Reg Retry Intvl High Rnd, on page 106
Reg Retry Long Intvl High Rnd, on page 107
Srv_Failback Before Failover n , on page 133
Hs Admin Pin n , on page 164

Hs Alarm Enable n , on page 64

Hs Alarm n_, on page 164

Hs Alert Tone n_, on page 165

Hs Alert Vol n , on page 165

Hs Auto_Answer n , on page 166

Hs Auto Keylock n , on page 166

Hs Bluetooth n , on page 167

Hs Charger Warn n_, on page 167

Hs Config Protocol, on page 65

Hs Config Server, on page 65
Hs_Config_Server Password, on page 66
Hs_Config_Server Username, on page 66
Hs Confirm Sound n , on page 168

Hs Coverage Warn n , on page 168

Hs Hide Number n , on page 169

Hs Idle Clock n , on page 169

Hs_Idle Screen n_, on page 170

Hs Key Sound n_, on page 170

Hs Led Green n , on page 171
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Release

What's New and Updated

Hs Led Orange n , onpage 171

Hs Led Red n_, on page 172

Hs Line n , on page 172

Hs Msg Display n , on page 173

Hs Msg Overwrite Old n , on page 173
Hs Msg Send n , on page 174

Hs Name n , on page 174

Hs Phone Lock n , on page 174

Hs Power Save n , on page 175

Hs Ptt n , on page 175

Hs Rec Alarm Enable n , on page 176
Hs Rec Alarm n , on page 176

Hs Ring Emerg High n , on page 177
Hs Ring Emerg Low n , on page 177
Hs Ring Emerg Mid n , on page 178
Hs Ring Mel n , on page 179

Hs Ring Norm Msg n , on page 179
Hs Ring Urgent Msg n , on page 180
Hs Ring Vol n_, on page 180

Hs Select Network n , on page 181

Hs Silent Charging n , on page 181

Hs Silent n , on page 182

Hs Unlock Pin n , on page 182

Hs Vibrate n_, on page 183
Call Id Map n_, on page 25

Call Id Map Subscription n_, on page 25
Call group SIP account n , on page 24
Subcsr_Call_Group_Subscribed , on page 141

Subscr_Intercom_Enabled , on page 145

Firmware Release 5.0(1)

Introduced the document for Cisco IP DECT 6800 Series XML parameters running SIP
Firmware Release 5.0(1) with Cisco BroadWorks version 22 and later.
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Revised: January 12, 2024

XML Tags for Base Station Settings

This section provides information about XML tags used for base station settings.

Admin_Password

¥BX ML Tag Name
i

Admin_Password
Example:

<Admin_Password>Testadminpwdl@</Admin_ Password>

Web Parameter

Admin Password

Default Value String up to 8 characters
Allowed Values String

Units String

Limits 128 characters

User or Admin

Exposed in admin level

Description

Indicates the administrator password.

Labels

Security

Allow_Call_Groups

¥BX ML Tag Name
i

Allow_Call Groups
Example:
<Allow Call Groups>On</Allow Call Groups>

This parameter is only applicable for 110 Single-Cell Base Station

Web Parameter None
Default Value On
Allowed Values * On
* Off
Units Options without units
Limits Option

User or Admin

Exposed in admin level
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Description Indicates if the local call group is enabled in the base station.

Labels None

Auth ID n_

¥BX ML Tag Name Auth ID n_
i

Example:

<Auth ID 1 >1234</Auth ID 1 >

Web Parameter Extension

Default Value None

Allowed Values String

Units String

Limits 128 characters

User or Admin Exposed in admin level

Description Indicates the SIP username or extension.
Labels Extensions

Auth_Resync_reboot_n_

XX ML Tag Name Auth Resync_reboot n_
tfi®

Example:

<Auth Resync reboot 1 >Enabled</ Auth Resync reboot 1 >

Web Parameter Auth Resync reboot
Default Value Enabled
Allowed Values * Enabled

* Disabled
Units Options without units
Limits Option
User or Admin Exposed in admin level
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Description Enabled—Indicates that the base requests authorization when there is a notification to
reset, check-sync, or reboot.

Labels Servers

Auto_Dect_Register

¥BX ML Tag Name Auto Dect Register
i

Example:

<Auto Dect Register>On</Auto Dect Register>

Web Parameter None
Default Value No
Allowed Values * On
* Off
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Controls whether to enable handset registration.
Labels None
Auto_Resync_Days
amBXML Tag Name Auto Resync_Days
ofid
ld Example:

<Auto_Resync Days>50</Auto Resync Days>

‘Web Parameter

Auto Resync Days

Default Value 1

Allowed Values Integer
Units Integer
Limits 0-365 digits

User or Admin

Exposed in admin level
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Description Indicates the number of days between resync operations.
Use this parameter with auto Resync Time, Auto Resync Polling,
AutoiResynciPeriodic,andAutoiResynciDelay

Labels Management

AVT_Dynamic_Payload_n_

¥BXML Tag Name
ifid

AVT Dynamic_ Payload n_
Example:

<AVT Dynamic Payload 1 >115</AVT Dynamic Payload 1 >

Web Parameter

DTMF Payload Type

Default Value 101
Allowed Values Integer
Units Integer
Limits 0-255 digits

User or Admin

Exposed in admin level

Description Indicates the type of DTMF payload when the DTMF Signaling field is set to RFC
2833.
Labels Servers
BLF_List URI_n_
\tBX ML Tag Name BLF List URI n_
utiB
Example:

<BLF_List URI_1 >MonitoredUsersList@sipurash22.com</BLF_List URI_1 >

Web Parameter None
Default Value None
Allowed Values String
Units String
Limits 9 characters

User or Admin

Exposed in admin level

18



Description Indicates the URI for Busy Lamp Field resource list on the BroadWorks application
server.

Only 10 characters are allocated for each URI . The server registrar field provides the
server information.

Labels None

Blind_Transfer Code

B ML Tag Name Blind Transfer Code
ifi®

Example:

<Blind Transfer Code>*90</Blind Transfer Code>

Web Parameter

Blind Transfer

Default Value *88
Allowed Values Integer
Units Integer
Limits 0-99 digits

User or Admin

Exposed in admin level

Description Indicates to dial this star code to transfer a call without consultation.
Labels Star Codes
Blind_Transfer_Serv_n_
mﬁ(ML Tag Name Blind Transfer Serv n
ufiB
Example:

<Blind Transfer Serv_1 >Enabled</Blind Transfer Serv_ 1 >

Web Parameter

Enable Blind Transfer

Default Value Disabled

Allowed Values * Enabled
 Disabled

Units Options without units

Limits Option

19



User or Admin Exposed in admin level

Description Indicates if you can transfer without consultation.

Labels Servers

Block ANC Act Code

\tBX ML Tag Name Block ANC_Act Code
fid

Example:

<Block ANC_Act_Code>*80</Block ANC_Act_Code>

Web Parameter

Block Anonymous Incoming Calls Activate

Default Value *77
Allowed Values Integer
Units Integer
Limits 0-99

User or Admin

Exposed in admin level

Description

Indicates to dial this star code to block calls that don't have a caller ID.

Labels

Star Codes

Block ANC_Deact Code

¥BXML Tag Name
itid

Block ANC Deact Code

Example:

<Block ANC Deact Code>*90</Block ANC Deact Code>

Web Parameter

Block Anonymous Incoming Calls Deactivate

Default Value *87
Allowed Values Integer
Units Integer
Limits 0-99

User or Admin

Exposed in admin level
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Description Indicates to dial this star code to all the phones to receive calls that don't have a caller

ID.
Labels Star Codes
Block_ANS_Setting
X_il-ﬂ(ML Tag Name Block ANS Setting
aid Example:

<Block_ANS_Setting>Yes</Block ANS_Setting>

Web Parameter None
Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Indicates if rejection of anonymous calls is enabled for a given subscription.
Labels None
Block_CID_Act_Code
X_ll_ﬁXML Tag Name Block CID Act Code
aid Example:
<Block CID Act Code>*75</Block CID Act Code>
Web Parameter Block Caller 1d On Outgoing Calls Activate
Default Value *67
Allowed Values Integer
Units Integer
Limits 0-99
User or Admin Exposed in admin level
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Description Indicates to dial this star code to not send the caller ID on an outgoing call.

Labels Star Codes

Block CID Deact Code

¥BX ML Tag Name Block CID Deact Code
i

Example:

<Block CID Deact Code>*70</Block CID Deact Code>

Web Parameter Block Caller ID On Outgoing Calls Deactivate
Default Value *68
Allowed Values Integer
Units Integer
Limits 0-99
User or Admin Exposed in Admin level
Description Indicates to dial this star code to send the caller ID on an outgoing call.
Labels Star Codes
Busy_Tone
X_ﬂ-ﬁ(ML Tag Name Busy Tone
ol Example:

<Busy_Tone>480@-19,620€-19;10(.5/.5/1+2)</Busy_Tone>

Web Parameter Busy Tone

Default Value 480@-19,620@-19;10(.5/.5/1+2)

Allowed Values String

Units String

Limits 256 characters

User or Admin Exposed in admin level

Description Plays the tone when an outbound call receives 486 RSC.
Labels Call Progress Tones
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Call Return_Code

¥BX ML Tag Name
il

Call Return Code

Example:

<Call Return Code>*75</Call Return Code>

Web Parameter Call Return
Default Value *69
Allowed Values Integer
Units Integer
Limits 0-99

User or Admin

Exposed in admin level

Description

Indicates to dial this star code to return a call.

Labels

Star Codes

Call_Waiting_Tone

¥BX ML Tag Name
il

Call Waiting_ Tone

Example:

<Call Waiting Tone>440@-10;30(.3/9.7/1)</Call Waiting Tone>

‘Web Parameter

Call Waiting Tone

Default Value 440@-10;30(.3/9.7/1)
Allowed Values String

Units String

Limits 256 characters

User or Admin

Exposed in admin level

Description

Indicates the tone that plays when a call is waiting.

Labels

Call Progress Tones
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Caller ID Header

¥BX ML Tag Name Caller ID Header
i

Example:

<Caller ID Header>1</Caller ID Header>

Web Parameter Remove Caller 1D Source Priority
Default Value 0 (PAI-FROM)
Allowed Values + 0: PAI-FROM

* 1: FROM

« 2: ALERT INFO - PAI -FROM

Units Options without units

Limits Option

User or Admin Exposed in admin level

Description Contains SIP information that Caller ID source uses.
Labels Servers

Call_group_SIP_account_n_

mﬁ(ML Tag Name Call group SIP account n_
nfib

Example:

<Call group SIP account 30>1000</Call group SIP account 30>

Web Parameter ldx

Default Value 1000

Allowed Values Integer

Units Integer

Limits 0-999

User or Admin Exposed in admin/user level

Description Indicates the 16-bit SIP account times the number of supported call groups.
Labels Local Call Groups
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Call_ld_Map_n_

\BX ML Tag Name Call Td Map n_
ifi®

Example:

<Call Id Map 1 >&<25:>xxxx</Call Id Map 1 >

Web Parameter Call Id Map

Default Value "

Allowed Values String

Units String

Limits 64 characters

User or Admin Exposed in admin/user level

Description Defines the caller ID to match the number in the contacts list.
Labels Dial Plans

Call_Id_Map_Subscription_n_

B ML Tag Name Call Id Map Subscription n
ufid Where, n is the handset extension index.
Example:

<Call Id Map Subscription 1 >2</Call Id Map Subscription 1 >

Web Parameter Caller ID Map

Default Value 1

Allowed Values 1-10

Units Digit

Limits 1to 10

User or Admin Exposed in admin/user level

Description Defines the caller ID index for the handset extension.

Labels Extensions > Terminal




Call_Statistics In SIP n_

¥BX ML Tag Name Call Statistics In SIP n
i

Example:

<Call_Statistics_In_SIP_1>Yes</Call_Statistics_In_ SIP_1>

Web Parameter Call Statistics in SIP
Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Adds the call quality statistics after the call ends to the end call message sent to the

third-party call control server.

Labels Servers

CDP

¥BXML Tag Name CDP
utiB
Example:
<CDP>Yes</CDP>
Web Parameter CDP Send
Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Controls the use of Cisco Discovery Protocol (CDP) on the base.

Labels

Network
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CDP_Delay

¥BX ML Tag Name
il

Example:

<CDP_Delay>100</CDP_Delay>

Web Parameter

CDP Send Delay

Default Value 60

Allowed Values Integer
Units Integer
Limits 0-255 digits

User or Admin

Exposed in admin level

Description

Identifies the length of time, in seconds, that the device waits between CDP messages.

Labels

Network

Certificate_use_only_trusted

\BX ML Tag Name
i@

Certificate use only trusted

Example:

<Certificate use only trusted>Yes</Certificate use only trusted>

Web Parameter

Use Only Trusted Certificates

Default Value Yes
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

* No—Accepts all the certificates from the server.

* Yes— Verifies if the configured value of the outbound proxy (A/AAAA record,
DNS SRV, or NAPTR domain) is present in the CN or SAN entry in the certificate
present in the server. If the value doesn't match the entry in the certificate in the
server, the TLS connection fails.

27



Labels Security

Cfg_Rep_OnChange

\BX ML Tag Name Cfg_Rep_OnChange
ofil
Web Parameter Config Change Report On-Change
Default Value X
Allowed Values Option list: Disabled|Enable
Units String
Limits X

User or Admin

Exposed in admin level

Description When enabled, a configuration update triggers a three minute timeout. Any configuration
changes made within the next three minutes restart the timer. When there is no change
in the configuration for three minutes, they are reported to the server.

Labels Management

Cfg_Rep_Period

\tBX ML Tag Name Cfg_Rep_Period
ofiB
Web Parameter Config Change Report Period
Default Value 0
Allowed Values Integer
Units hours
Limits 0-744

User or Admin

Exposed in admin level

Description Periodic reporting transmits changes to the configuration server at a defined period of
hours after the configuration is set.
Labels Management

28



Cfwd _All Act Code

¥BX ML Tag Name
il

Cfwd_All Act_ Code

Example:

<Cfwd All Act Code>*80</Cfwd All Act Code>

Web Parameter

Call Forward All Activate

Default Value *72
Allowed Values Integer
Units Integer
Limits 0-99 digits

User or Admin

Exposed in admin level

Description

Indicates to dial this star code to forward all calls.

Labels

Star Codes

Cfwd_All Deact Code

¥BX ML Tag Name
il

Cfwd_All Deact_Code

Example:

<Cfwd_All Deact_ Code>*85</Cfwd_All Deact_Code>

‘Web Parameter

Call Forward All Deactivate

Default Value *73
Allowed Values Integer
Units Integer
Limits 0-99 digits

User or Admin

Exposed in admin level

Description

Indicates to dial this star code to stop make calls ring on the phone again.

Labels

Star Codes
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Cfwd _AIl Dest n_

\BX ML Tag Name Cfwd All Dest n_
il

Example:

<Cfwd All Dest 1 >1234/Cfwd All Dest 1 >

Web Parameter

Forwarding Unconditional Number

Default Value None
Allowed Values Integer

Units Integer
Limits 21 characters

User or Admin

Exposed in admin level

Description Identifies the number to dial when an incoming call arrives for the handset.
Applies to all incoming calls.
Labels Extensions > Add or Edit Extension

Cfwd _AIl Serv n_

\BX ML Tag Name Cfwd All Serv_n_
(i

Example:

<Cfwd All Serv_ 1 >Yes</Cfwd All Serv 1 >

‘Web Parameter

Forwarding Unconditional Number

Default Value Yes
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Identifies if call forward unconditional is available.
Applies to all incoming calls.
Labels Extensions > Add or Edit Extension
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Cfwd_Busy_Dest_n_

¥BX ML Tag Name
il

Cfwd_Busy Dest n_

Example:

<Cfwd Busy Dest 1 >1234</Cfwd Busy Dest 1 >

Web Parameter

Forwarding on Busy Number

Default Value None
Allowed Values String
Units String
Limits 21 characters

User or Admin

Exposed in admin level

Description Identifies the number to dial when the handset is busy.
Applies when the handset is on an existing call.
Labels Extensions > Add or Edit Extension

Cfwd_Busy_Serv_n_

¥BX ML Tag Name
il

Cfwd_Busy_Serv_n_

Example:

<Cfwd_Busy_ Serv_1 >Yes</Cfwd Busy_Serv_1 >

‘Web Parameter

Forwarding on Busy Number

Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Identifies if call forward busy is available.
Applies when the handset is on an existing call.
Labels Extensions > Add or Edit Extension
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Cfwd_No_Ans_Delay_n

\BX ML Tag Name Cfwd No_Ans_Delay n
il

Example:

<Cfwd No_Ans Delay 1>90</Cfwd No_ Ans_ Delay 1>

Web Parameter Forwarding No Answer Number

Default Value 90

Allowed Values Integer

Units Seconds

Limits 1-255

User or Admin Exposed in admin level

Description Indicates the wait time in seconds before the call is considered unanswered.

Applies to all unanswered calls.

Labels Extensions > Add or Edit Extension

Cfwd No Ans Dest n_

\BX ML Tag Name Cfwd No Ans_Dest n_
ifi®

Example:

<Cfwd No_ Ans Dest 1 >1234</Cfwd No Ans Dest 1 >

Web Parameter Forwarding No Answer Number

Default Value None

Allowed Values String

Units String

Limits 21 characters

User or Admin Exposed in admin level

Description Indicates the number to dial when an incoming call arrives for the handset and isn’t
answered.

Applies to all unanswered calls.

Labels Extensions > Add or Edit Extension
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Cfwd No Ans Serv n_

\BX ML Tag Name Cfwd No Ans_Serv_n_
il

Example:

<Cfwd_No_Ans_Serv_1 >Yes</Cfwd No_Ans_Serv_n_>

Web Parameter

Forwarding No Answer Number

Default Value Yes
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Indicates if call forward no answer is available.
Applies to all unanswered calls.
Labels Extensions > Add or Edit Extension

Conference_Bridge_URL_n_

¥BXML Tag Name
i@

Conference Bridge URL n_

Example:

<Conference Bridge URL 1 >conference@server.com</Conference Bridge URL 1 >

Web Parameter

Conference Server

Default Value None
Allowed Values Server URL
Units Server URL
Limits 63 characters

User or Admin

Exposed in admin level

Description

Indicates the IP address or URL of the service provider's conference server, if available.

Labels

Servers
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Conference Serv n_

\BX ML Tag Name Conference Serv n
ofi®

Example:

<Conference Serv_ 1 >Yes</Conference Serv n >

Web Parameter

Enable Conference Server

Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Controls the use of the external conference server.
If the value is ves, an external conference server is configured.
When the user starts a conference, the handset starts a conference on the configured
conference server.
Labels Servers
Conference_Tone
\BX ML Tag Name Conference Tone
ofid
Example:

<Conference Tone>350€-19;20(.1/.1/1,.1/9.7/1)</Conference Tone>

Web Parameter

Conference Tone

Default Value 350@-19;20(.1/.1/1,.1/9.7/1)
Allowed Values String

Units String

Limits 256 characters

User or Admin

Exposed in admin level

Description

Indicates the tone that plays to all parties when a three-way conference call is in progress.
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Labels

Call Progress Tones

ConfigurationDownloadCtrl

¥BXML Tag Name
i@

ConfigurationDownloadCtrl
Example:

<ConfigurationDownloadCtrl>3</ConfigurationDownloadCtrl>

Web Parameter

Configuration File Download

Default Value 1
Allowed Values Integer
Units Integer
Limits 0-3 digits

User or Admin

Exposed in admin level

Description

Indicates the type of configuration file for the base station.

* 0: Download/resync disabled

+ 1: Base Specific File. The base station expects a filename in the format [mac
address] .xml

* 2: Multi Cell specific File. The base station expects a filename in the format
MultiCell [chain id].cfgq.

* 3: Base and Multi Cell Specific File. The base station expects a filename in the
formats [mac address].xml andMultiCell [chain id].cfg.

Labels

Management

Confirm_Tone

\BX ML Tag Name
itid

Confirm Tone

Example:

<Confirm Tone>600@-16;1(.25/.25/1)</Confirm Tone>

Web Parameter

Confirm Tone

Default Value

600@-16;1(.25/.25/1)

Allowed Values

String
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Units

String

Limits

256 characters

User or Admin

Exposed in admin level

Description

Indicates the brief tone to notify the acceptance of the last input value to the user.

Labels

Call Progress Tones

Connection_Type

¥BX ML Tag Name
i@

Connection Type

Example:

<Connection Type>DHCP</Connection Type>

Web Parameter

DHCP/Static IP

Default Value DHCP
Allowed Values * DHCP
« Static
Units String
Limits None

User or Admin

Exposed in admin level

Description Indicates the method that the device gets the TCP/IP parameters.
* DHCP: Automatically allocated from a pool of addresses. If DHCP is used, the
other IP settings or options can't be set.
* Static: Manually set.
Labels Network

Country_Region_ID

¥BX ML Tag Name
i@

Country Region_ ID
Example:

<Country Region Id>4</Country Region Id>

Web Parameter

State / Region

Default Value

Alabama

36



Allowed Values List of options

Units Options without units

Limits Option

User or Admin Exposed in user/admin level
Description Defines the selected state or region
Labels Country

Country_Variant_ID

Mﬁ(ML Tag Name Country Variant ID
i

Example:

<Country Variant Id>US</Country Variant Id>

Web Parameter Select Country

Default Value UsS

Allowed Values List of options

Units Options without units
Limits Option

User or Admin Exposed in user/admin level
Description Defines the selected country
Labels Country

CW _Act Code

¥BX ML Tag Name CW Act Code
i@

Example:

<CW_Act_Code>*65</CW_Act_Code>

Web Parameter Call Wait Activate
Default Value *56
Allowed Values Integer

Units Integer




Limits

0-99 digits

User or Admin

Exposed in admin level

Description

Indicates to dial this star code to enable the call waiting tone.

Labels

Star Codes

CW Deact Code

¥BX ML Tag Name
i

CW_Deact Code

Example:

<CW_Deact_ Code>*70</CW_Deact_Code>

‘Web Parameter

Call Wait Deactivate

Default Value *57
Allowed Values Integer
Units Integer
Limits 0-99

User or Admin

Exposed in admin level

Description

Indicates to dial this star code to disable the call waiting tone.

Labels

Star Codes

CW_Setting_n_

¥BX ML Tag Name
i

CW _Setting n
Example:

<CW_Setting 1 >Yes</CW_Setting 1 >

Web Parameter

Call waiting feature

Default Value Yes
Allowed Values * Yes
* No
Units Options without units
Limits Option
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User or Admin

Exposed in admin level

Description Identifies if the call waiting is available on the phone. If the value is ves, the handset
receives an indication of a second incoming call while on another active call.
Labels Extensions > Add or Edit Extension

Daylight_Saving_Time_By_ Country_Region

¥BXML Tag Name
i

Daylight Saving Time By Country Region
Example:

<Daylight Saving Time By Country Region>No</Daylight Saving Time By Country Region>

Web Parameter

Set timezone by country/region

Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Indicates that the base station uses the timezone setting from the country and state/region

Labels

Country

Daylight_Saving_Time_Enable

¥BX ML Tag Name
i@

Daylight Saving Time Enable
Example:

<Daylight Saving Time Enable>Auto</Daylight Saving Time Enable>

Web Parameter

Set DST by country/region

Default Value Auto
Allowed Values * Auto
* Disabled
Units Options without units
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Limits Option

User or Admin Exposed in admin level
Description Indicates the use of daylight savings time (DST) for the state or region.
Labels Country

Daylight_Saving_Time_Rule

\BX ML Tag Name Daylight Saving_Time Rule
i

Example:

<Daylight Saving Time Rule>start=3/0/7/2;end=11/0/7/2;save=1</Daylight Saving Time Rule>

Web Parameter Daylight Saving Time (DST)

Default Value start=3/0/7/2;end=11/0/7/2;save=1

Allowed Values Start=month/start date/day/time; End=month/end date/day/time;Save=Automatic
Units String

Limits None

User or Admin Exposed in admin level

Description Indicates the configuration of daylight saving time. These are the values for Save:

» Automatic—Uses the settings associated with the country.
* Enabled—You need to set the rest of the DST fields.

* Disabled—No DST required.

Labels Country

Debug_Level

\BX ML Tag Name Debug Level
i@

Example:

<Debug Level>1</Debug Level>

Web Parameter Syslog Level

Default Value 1

40



Allowed Values * 0: Syslog off
* 1: Normal Operation

* 2: System Analyze

* 3: Debug
Units Integer
Limits 0-3 digits
User or Admin Exposed in admin level
Description Identifies the level of system-level log messages to save on the syslog server.

* 0: Syslog off—No messages saved.

* 1: Normal Operation—Normal message for: operational events, incoming calls,
outgoing calls, handset registration, DECT location, call lost due to busy, critical
system errors, and general system information.

* 2: System Analyze—Captures logs for handset roaming and handset firmware
updates status. The system analyze level also contains the messages from normal
operation.

* 3: Debug—Captures logs for debugging problems.

Note Don't enable System Analyze and Debug logs during normal
operation. These logs can result in system slowdown.

Labels Management

DHCP_Option_To_Use

¥BX ML Tag Name DHCP Option To Use
itid

Example:

<DHCP_ Option To Use>66,160,159,150,60</DHCP Option To Use>

Web Parameter DHCP option priority
Default Value 66,160,159,150,60
Allowed Values String

Units String

Limits 31 characters

User or Admin Exposed in admin level
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Description Identifies the priority of the DHCP options.

Labels Management

Dial Plan n_

¥BX ML Tag Name Dial Plan n_
i

Example:

<Dial Plan 4 >*xx|#xx|xx.|+x.</Dial Plan 4 >

Web Parameter Dial Plan ID

Default Value None

Allowed Values String. The value n is between o to 10.
Units String

Limits 255 characters

User or Admin Exposed in admin level

Description Identifies the index of the dial plan.
Labels Terminal

Dial_Plan_Subscription_n_

¥t ML Tag Name Dial Plan Subscription n_
tfi®

Example:

<Dial Plan Subscription 1 >1</Dial Plan Subscription 1 >

Web Parameter Dial Plan ID

Default Value 1

Allowed Values Integer

Units Integer

Limits 1-10 digits

User or Admin Exposed in admin level

Description Indicates the index of the dial plan. The value of this parameter is bial Plan n_where

n is the index of the dial plan.
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Labels

Extensions > Terminal

Directory_Enable

¥BXML Tag Name
i@

Directory Enable

Example:

<Directory Enable>Yes</Directory Enable>

Web Parameter None
Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Indicates whether the XSI phonebook is enabled.

Set the parameter Directory Enable to No when you use LDAP for directory

(phonebook_server_location = 1).

Set the XML parameter Phonebook_Server Location to 2 to use XSI.

Labels

None

Directory_Enterprise_Common_Enable

\BX ML Tag Name
i@

Directory Enterprise Common Enable

<Directory Enterprise Common Enable>No</Directory Enterprise Common Enable>

Web Parameter

EnterprissCommon

Default Value

Allowed Values

Units

Options without units

43



Limits Option

User or Admin Exposed in admin level
Description Allows to enable the Enterprise Common directory.
Labels Central Directory

Directory_Enterprise_Common_Name

¥BX ML Tag Name Directory Enterprise Common Name
utiB

Example:

<Directory Enterprise Common Name>EnterpriseCommen</Directory Enterprise Common Name>

Web Parameter EnterpriseCommon

Default Value EnterpriseCommon

Allowed Values String

Units String

Limits 39 characters

User or Admin Exposed in admin level

Description Indicates the display name of the Enterprise Common directory in the handset. For example, if this

field is set to "Company", the handset displays "Company" instead of "Enterprise Common".

Labels Central Directory

Directory_Enterprise_Name

¥BX ML Tag Name Directory Enterprise Name
i

Example:

<Directory Enterprise Name>Company</Directory Enterprise Name>

Web Parameter Enterprise
Default Value Enterprise
Allowed Values String

Units String
Limits 39 characters
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User or Admin

Exposed in admin level

Description

Indicates the display name of the Enterprise directory in the handset.

Labels

Central Directory

Directory_Enterprise_Enable

¥BXML Tag Name
ifid

Directory Enterprise Enable
Example:

<Directory Enterprise Enable>No</Directory Enterprise Enable>

Web Parameter Enterprise
Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Allows to enable the Enterprise directory.

Labels

Central directory

Directory_Group_Common_Enable

¥BX ML Tag Name
ifi®

Directory Group Common Enable

Example:

<Directory Group Common Enable>No</Directory Group Common Enable>

Web Parameter GroupCommon
Default Value No
Allowed Values * Yes
* No
Units Options without units
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Limits Option

User or Admin Exposed in admin level
Description Allows to enable the Group Common directory.
Labels Central Directory

Directory_Group_Common_Name

¥BX ML Tag Name Directory Group_ Common Name
utiB

Example:

<Directory Group Common Name>EnterpriseCommon</Directory Group Common_ Name>

Web Parameter GroupCommon

Default Value EnterpriseCommon

Allowed Values String

Units String

Limits 39 characters

User or Admin Exposed in admin level

Description Indicates the display name of the Group Common directory in the handset
Labels Central Directory

Directory_Group_Name

¥BX ML Tag Name Directory Group Name
utiB

Example:

<Directory Group Name>Group</Directory Group Name>

Web Parameter Group

Default Value Group

Allowed Values String

Units String

Limits 39 characters

User or Admin Exposed in admin level
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Description

Indicates the display name of the Group directory in the handset

Labels

Central Directory

Directory_Group_Name_Enable

¥BX ML Tag Name
i

Directory Group Name Enable

Example:

<Directory Group Name Enable>No</Directory Group_ Name Enable>

Web Parameter Group
Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Allows to enable the Group directory.

Labels

Central directory

Directory_Personal_Name

¥BX ML Tag Name
i@

Directory Personal Name

Example:

<Directory Personal Name>Home</Directory Personal Name>

Web Parameter Personal
Default Value Personal
Allowed Values String

Units String
Limits 39 characters

User or Admin

Exposed in admin level

Description

Indicates the display name of the Personal directory in the handset
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Labels Central Directory

Directory_Personal_Name_Enable

¥BXML Tag Name Directory Personal Name Enable
i

Example:

<Directory Personal Name Enable>No</Directory Personal Name Enable>

Web Parameter Personal
Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Allows to enable the Personal directory.
Labels Central Directory

Display_Name_n_

mﬁ(ML Tag Name Display Name n_
)

Example:

<Display Name 1 >Line 1</Display Name 1 >

Web Parameter Display Name

Default Value None

Allowed Values String

Units String

Limits 29 characters

User or Admin Exposed in admin level

Description Identifies the name to display on the handset.
Labels Extensions > Add or Edit Extension
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DND Act Code

¥BX ML Tag Name
il

DND_Act_Code

Example:

<DND_Act_Code>*80</DND_Act_Code>

Web Parameter

Do Not Disturb Activate

Default Value *78
Allowed Values Integer
Units Integer
Limits 0-99 digits

User or Admin

Exposed in admin level

Description

Indicates the star code to dial to stop calls ringing on the phone.

Labels

Star Codes

DND Deact Code

¥BX ML Tag Name
il

DND_Deact_Code

Example:

<DND_Deact_Code>*85</DND_Deact_Code>

‘Web Parameter

Do Not Disturb

Default Value *79
Allowed Values Integer
Units Integer
Limits 0-99

User or Admin

Exposed in admin level

Description

Indicates the star code to dial to allow calls to ring on the phone.

Labels

Star Codes
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DTMF_Tx_Method_n_

¥BX ML Tag Name
il

DTMF Tx Method n

Example:

<DTMF_Tx Method 1 >AVT</DTMF Tx Method 1 >

Web Parameter

DTMF Signalling

Default Value AVT
Allowed Values * INFO
* AVT
« AVT_AND_INFO
Units String
Limits None

User or Admin

Exposed in admin level

Description

Controls how to handle DTMF.
* INFO—Advertises the support for SIP INFO DTMF.
* AVT: RTP Events (RFC2833)—Advertises the support for RFC2833 DTMF.

* AVT AND_INFO: SIP-Info and RTP Events (RFC2833)—Advertises the support
for SIP INFO and RFC2833 DTMF.

Labels

Servers

Dual_Cell_Replacement_Timeout

¥BX ML Tag Name
il

Dual Cell Replacement Timeout
Example:
<Dual Cell Replacement Timeout>15</Dual_Cell Replacement Timeout>

This parameter is only applicable for 110 Single-Cell Base Station.

Web Parameter

Base Replacement Timeout (15-255 Min)

Default Value 60
Allowed Values Integer
Units Minutes
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Limits

Integer ranges from 15 to 255

User or Admin

Exposed in admin level

Description

Indicates the time to replace the base station.

Labels

Dual Cell

Emergency_Alarm_Block_Time

¥BX ML Tag Name
il

Emergency Alarm Block Time

Example:

<Emergency Alarm Block Time>10</Emergency Alarm Block Time>

Web Parameter None
Default Value 0
Allowed Values Integer
Units Seconds
Limits 0-254

User or Admin

Exposed in admin level

Description

Indicates the period in which a new alarm can't interrupt an active alarm.

Labels

None

Emergency_Alarm_Howling_n_

x_ll.ﬁ(ML Tag Name Emergency Alarm Howling n_
uil Example:
<Emergency Alarm Howling 1 >Disabled</Emergency Alarm Howling 1 >
Web Parameter Howling
Default Value Disabled
Allowed Values * Disabled
* Enabled
Units Options without units

Limits Option




User or Admin Exposed in admin level

Description Indicates if the handset should start the howling signal.

If disabled, only the call or message signal is sent.

Labels Alarm

Emergency_Alarm_Number_n_

mﬁ(ML Tag Name Emergency Alarm Number n_
i
Example:

<Emergency_ Alarm Number n_ >1234056</Emergency Alarm Number n >

Web Parameter list of numbers

Default Value None

Allowed Values Integer

Units Integer

Limits 0-7 digits

User or Admin Exposed in admin level

Description Indicates the defined emergency numbers.
Labels Management

Emergency_Alarm_Priority_n_

mﬁ(ML Tag Name Emergency Alarm Priority n
afid
B Example:

<Emergency Alarm Priority 1 >0x00</Emergency Alarm Priority 1 >

Web Parameter ldx

Default Value 0x00

Allowed Values Hexadecimal

Units Hexadecimal

Limits 0-7 digits

User or Admin Exposed in admin level
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Description Indicates the priority of the alarm. A higher priority alarm can interrupt an active lower
priority alarm.

Labels Alarm

Emergency_Alarm_Signal_n_

mﬁ(ML Tag Name Emergency Alarm Signal n_
i
Example:

<Emergency Alarm Signal 1 >0x01</Emergency Alarm Signal 1 >

Web Parameter Alarm Signal
Default Value 0x01
Allowed Values * 0x01
* 0x02
Units Hexadecimal
Limits Hexadecimal
User or Admin Exposed in admin level
Description Indicates how the alarm signals when the handset activates the alarm (Emergency)
button.

* 0x01: Message—A text message is sent to the alarm server.

* 0x02: Call—An outgoing call is placed to the specified emergency number.

Labels Alarm

Emergency_Alarm_Stop_Allowed_n_

mﬁ(ML Tag Name Emergency Alarm Stop Allowed n
6tid

Example:

<Emergency Alarm_Stop Allowed_1_>Yes</Emergency Alarm Stop_Allowed 1 >

Web Parameter Stop Alarm from Handset
Default Value Yes
Allowed Values * Yes

* No
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Units Options without units

Limits Option

User or Admin Exposed in admin level

Description Identifies if the handset can cancel the alarm.
Labels Alarm

Emergency_Alarm_Type_n_

mML Tag Name Emergency Alarm Type n_
ifi®

Example:

<Emergency Alarm Type 1 >0x04</Emergency Alarm Type 1 >

Web Parameter Alarm Type

Default Value 0x04

Allowed Values Hexadecimal

Units Hexadecimal

Limits 4 and 5

User or Admin Exposed in admin level
Description Identifies the type of alarm.

* 4: Alarm Button

 5: Disabled

Labels Alarm

Emergency_Number_n_

mﬁ(ML Tag Name Emergency Number n
6tid

Example:

<Emergency Number 1 >0</Emergency Number 1 >

Web Parameter Alarm Number
Default Value 0
Allowed Values Integer
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Units

Integer

Limits

20 digits

User or Admin

Exposed in admin level

Description Identifies the number to dial when a user presses and holds the Emergency button on
the handset for 3 seconds or more.
Labels Terminal

Emergency_Pre_Alarm_Delay_n_

¥BX ML Tag Name
i@

Emergency Pre Alarm Delay n_

Example:

<Emergency Pre Alarm Delay 1 >0</Emergency Pre Alarm Delay 1 >

Web Parameter

Pre-Alarm Delay

Default Value 0

Allowed Values Integer
Units Integer
Limits 0-255 digits

User or Admin

Exposed in admin level

Description Indicates the delay between the time the pre-alarm displays and the time the alarm
signals.
Labels Alarm

Emergency_Pre_Alarm_Stop_Allowed_n_

\BX ML Tag Name
i@

Emergency Pre Alarm Stop Allowed n_

Example:

<Emergency Pre Alarm Stop Allowed 1 >Yes</Emergency Pre Alarm Stop Allowed 1 >

Web Parameter

Stop Pre-Alarm from Handset

Default Value Yes
Allowed Values * Yes
* No
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Units Options without units

Limits Option

User or Admin Exposed in admin level

Description Identifies if the user can stop an alarm.
Labels Alarm

Emergency_Profile_Alias_n_

mML Tag Name Emergency Profile Alias n_
fid

Example:

<Emergency Profile Alias 1 >Emergency</Emergency Profile Alias 1 >

Web Parameter Profile Alias

Default Value None

Allowed Values String

Units String

Limits 19 characters

User or Admin Exposed in admin level

Description Identifies the name of the alarm. This parameter is available only if you set the value

of the parameter Emergency Alarm Type n_ to 4(Alarm Button).

Labels Alarm

Emergency_Trigger_Delay n_

mﬁ(ML Tag Name Emergency Trigger Delay n_
i@

Example:

<Emergency Trigger Delay 1 >0</Emergency Trigger Delay 1 >

Web Parameter Trigger Delay
Default Value 0

Allowed Values Integer

Units Integer
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Limits

0-255 digits

User or Admin

Exposed in admin level

Description

Identifies the delay in seconds before the handset displays a pre-alarm warning.
* 0—No pre-alarm warning; the alarm is sent immediately.

* Other—The amount of time that the pre-alarm warning displays. When the number
of seconds passes, the alarm is sent. It may take a few seconds for the alarm to be
sent to the configured location.

Labels

Alarm

Enable_Protocol

¥BX ML Tag Name
i@

Enable Protocol

Example:

<Enable Protocol>HTTPS</Enable Protocol>

Web Parameter

Secure HTTP

Default Value HTTPS
Allowed Values « HTTP
« HTTPS
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Indicates the protocol to access the base station web page.

Labels

Security

Enable Web Server

\BX ML Tag Name
i@

Enable Web_ Server

Example:

<Enable Web Server>Yes</Enable Web Server>

Web Parameter

None
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Default Value Yes

Allowed Values * Yes
* No
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Indicates to allow to edit the configuration on the web server. If the value is ves, it

allows to edit the configuration on the web server.

Labels None

Encryption_Method_n_

\BX ML Tag Name Encryption Method n_
il

Example:

<Encryption Method 1 >0</Encryption Method 1 >

Web Parameter SRTP Crypto Suites
Default Value 0
Allowed Values «0: AES CM 128 HMAC SHA1 32, AES CM 128 HMAC SHAI 80

«1: AES_CM_128 HMAC_SHA1 80, AES_CM_128 HMAC_SHAI 32
«2: AES_CM_128 HMAC_SHA1 32
«3: AES_CM_128 HMAC_SHA1 80

Units Options without units

Limits Option

User or Admin Exposed in admin level

Description Indicates the list of supported SRTP Crypto Suites. Each device starts with two suites.

You can change the order of the suites.

Labels Servers
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Feature_Key_Sync_n_

\BX ML Tag Name Feature Key Sync n_
ofi®

Example:

<Feature Key Sync 1 >Disabled</Feature Key Sync 1 >

Web Parameter BroadWorks Feature Event Package
Default Value Disabled
Allowed Values * Disabled
* Enabled
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Identifies if the BroadWorks feature key sync package is available. Features include:

do not disturb, call forward (all, busy, no answer).

Only applicable to BroadSoft SIP servers. Must be enabled on the SIP server.

Labels Extensions > Add or Edit Extension

FilenameMultiSpecific

mﬁ(ML Tag Name FilenameMultiSpecific
i

Example:

<FilenameMultiSpecific>LINKID 012345.xml</FilenameMultiSpecific>

Web Parameter Multi Cell Specific File
Default Value None

Allowed Values String

Units String

Limits 31 characters

User or Admin Exposed in admin level




Description This parameter is the second configuration file to download and use for multicell
configuration. This parameter is dependent on the parameters
NETWORK CONFIGURATION_ SERVER and
CONFIGURATION DOWNLOAD CTRL.

If this filename is empty, the NETWORK SYNC ID adds the ID to this filename
MultiCell ID.cfgq.

Labels Management
Firewall
xtnBx ML Tag Name Firewall
aid Example:

<Firewall>[Parameter]</Firewall>

Web Parameter Firewall

Default Value Enabled

Allowed Values Enabled|Disabled

Units

Limits List

User or Admin Exposed in admin level

Description Enables statefull firewall to control incoming network traffic for Cisco IP DECT 110

Single-Cell Base Station and Cisco IP DECT 210 Multi-Cell Base Station.

Labels Security

Firewall_Config

XML Tag Name Firewall Config
itid

Example:

<Firewall Config
ua="na”>NO_ ICMP_ PING,TCP:12000,UDP:8000:8010</Firewall Config>

Web Parameter

Default Value Blank
Allowed Values NO_ICMP_PING [NO_ICMP_UNREACHABLE|NO NONDEFAULT TFTP
Units Options without limits
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Limits Options

User or Admin Exposed in admin level
Description Configures firewall for port range.
Labels Security
Gateway
\BX ML Tag Name Gateway
utiB
Example:

<Gateway>192.168.0.1</Gateway>

Web Parameter Default Gateway

Default Value None

Allowed Values IP address

Units IP address

Limits IP address

User or Admin Exposed in admin level

Description Indicates the [Pv4 address of the default network router or gateway.

You can change this parameter only if DHCP is not enabled.

Labels Network

Group_Paging_Script_n_

anBx ML Tag Name Group Paging Script n

ufid Example:
<Group Paging Script 1 >pggrp=224.168.168.169:34560;
name=All;num=500; listen=yes;pri=0</Group Paging Script 1 >
Web Parameter Group 1-3 Paging Script
Default Value None

Allowed Values String. The value n is 1 to 3.

Units String

Limits 128 characters




User or Admin Exposed in admin level

Description A string to configure the phone to listen and initiate multicast paging. Each string can have a maximum length
of 128 characters. You can add a phone to up to 3 paging groups.

Labels Management

Handle VIA received n_

mﬁ(ML Tag Name Handle VIA received n_
Gfid
Example:

<Handle VIA received 1 >No</Handle VIA received 1 >

Web Parameter NAT Adaption
Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Indicates how to handle SIP messages in a SIP-aware router.

* Yes—When the system receives a SIP response to a REGISTER request with a
Via header that includes the received parameter, the base adapts its contact
information to the IP address from the received parameter. For example, via:
SIP/2.0/UDP 10.1.1.1:4540;received=68.44.20.1. The base issues another
REGISTER request with the updated contact information.

No—The received parameter is ignored.

Labels Servers

Handset_Alarm_Auto_Stop_Allowed

¥BX ML Tag Name Handset Alarm Auto Stop Allowed
ufiB

Example:

<Handset Alarm Auto Stop Allowed>Disabled</Handset Alarm Auto Stop Allowed>

Web Parameter Auto Stop Alarm
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Default Value Disabled
Allowed Values * Disabled
e Enabled
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Indicates if the handset should stop the automatic emergency notification.
* Disabled—The handset doesn't stop notification.
» Enabled—The handset stops the notification after the number of seconds set in
Auto Stop Alarm Delay.
Labels Management

Handset_Alarm_Auto_Stop_Delay

¥BX ML Tag Name
i@

Handset Alarm Auto Stop Delay

Example:

<Handset Alarm Auto Stop Delay>30</Handset Alarm Auto Stop Delay>

Web Parameter

Auto Stop Alarm Delay(s)

Default Value 30

Allowed Values Integer
Units Seconds
Limits 0-255 digits

User or Admin

Exposed in admin level

Description

Indicates the time (in seconds) before the handset stops automatic emergency notification.

Labels

Management
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Handset_Keepalive_Delay

¥BX ML Tag Name Handset Keepalive Delay
nfiB

Example:

<Handset Keepalive Delay>0</Handset Keepalive Delay>

Web Parameter Keep Alive (m)

Default Value 0

Allowed Values Integer

Units Minutes

Limits 0-255

User or Admin Exposed in admin level

Description Indicates the length of time in minutes that the handset waits before sending an automatic

emergency notification message to the server.

If the value is not 0, the handset doesn't send notifications.

Labels Management

Hs Alarm_Enable n_

Xﬂﬁ(ML Tag Name Hs Alarm Enable n_
tid

Example:

<Hs_Alarm Enable_ 1 >Yes</Hs_Alarm Enable 1 >

Default Value Yes
Allowed Values * Yes
* No
Units Options without units
Limits Option
Description Specifies that the alarm is enabled.
Handset Menu None
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Hs_Config_Protocol

XML Tag Name Hs Config Protocol
ifi®

Example:

<Hs Config Protocol>IPv4</Hs Config Protocol>

Web Parameter Protocol
Default Value IPv4
Allowed Values * [Pv4
* [Pv6
Units Options without units
Limits Option
Description Indicates the protocol to download the handset configuration file.
Labels Management

Hs_Config_Server

Mﬁ(ML Tag Name Hs Config Server
i

Example:

<Hs_Config Server>https://cisco.com/path/handset.xml</Hs_Config Server>

Web Parameter Configuration server and file

Default Value None

Allowed Values URL

Units URL

Limits URL

Description Defines the server and the handset configuration file to download.
Labels Management
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Hs_Config_Server_Password

XML Tag Name Hs Config Server Password
ifi®

Example:

<Hs_Config Server Password>Abcdl23</Hs_Config Server Password>

Web Parameter Password

Default Value None

Allowed Values String

Units String

Limits 40 characters

Description Indicates the password to access the handset configuration server.
Labels Management

Hs_Config_Server_Username

mﬁ(ML Tag Name Hs Config Server Username
upid Example:

<Hs_Config Server_ Username>LoginName</ Hs_Config Server Username >

Web Parameter Username

Default Value None

Allowed Values String

Units String

Limits 40 characters

Description Indicates the username to access the handset configuration server.
Handset Menu Management
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Hebu Mode

¥BX ML Tag Name
il

Hebu Mode

Example:

<Hebu_Mode>enabled</Hebu_ Mode>

Web Parameter

Assing HS to Ext by Credentials

Default Value Disabled

Allowed Values e Enabled
 Disabled

Units Options without units

Limits Options

User or Admin

Exposed in admin level

Description

Indicates if the Handset Extension by Username (HEBU) is enabled.

Labels

Management

Held_Company_Id

¥BXML Tag Name
i@

Held Company Id
Example:

<Held Company Id>ABC123</Held Company Id>

Web Parameter

HELD Company ID

Default Value None
Allowed Values String
Units String
Limits 40 characters

User or Admin

Exposed in admin level

Description

Specifies the HTTP Enabled Location Delivery company account ID (RedSky).

Labels

Management
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Held Token Srvn

¥BX ML Tag Name Held Token Srvn
ufid Where n is 1 for the primary HELD server and 2 for the secondary HELD server.
Example:

<Held Token Srvl></Held Token Srvl>

<Held Token Srv2></Held Token Srv2>

Web Parameter Primary HELD Server

Default Value Empty

Allowed Values String

Units String

Limits 128 characters

User or Admin Exposed in admin level

Description Specifies the primary or secondary HELD server.
Labels Management

Holding_Tone

¥BX ML Tag Name Holding Tone
il

Example:

<Holding Tone>600€-19;*(.1/.1/1,.1/.1/1,.1/9.5/1)</Holding Tone>

Web Parameter Holding Tone

Default Value 600@-19;*(.1/.1/1,.1/.1/1,.1/9.5/1)

Allowed Values String

Units String

Limits 256 characters

User or Admin Exposed in admin level

Description Informs the local caller that the far end has placed the call on hold.
Labels Call Progress Tones
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Insert_VIA_rport

¥BX ML Tag Name
il

Insert VIA rport

Example:

<Insert VIA rport>No</Insert VIA rport>

Web Parameter

Enable RPORT

Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Indicates the use of RPORT in SIP messages.

Labels

Network

leee1588 Enabled

¥BXML Tag Name
i@

Ieeel588 Enabled

Example:

<Ieeel588 Enabled>No</Ieeel588 Enabled>

Web Parameter IEEE1588
Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Indicates the use of LAN synchronization for Multicell synchronization between the
base stations.
Labels LAN Sync
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leee1588 Zone Multicast Alt Domain

\BX ML Tag Name Teeel588 Zone Multicast Alt Domain
nfiB
3 Example:

<Ieeel588_ Zone Multicast Alt Domain>80
</Ieeel588 Zone Multicast Alt Domain>

Web Parameter Alternativ Domain Number

Default Value 64

Allowed Values Integer

Units Integer

Limits 0-127 digits

User or Admin Exposed in admin level

Description Indicates the alternate Zone Multicast Domain number to use with this parameter.
Labels LAN Sync

leee1588 Zone Multicast Domain

¥BX ML Tag Name Ieeel588 Zone Multicast Domain
ofid

Example:

<Ieeel588 Zone Multicast Domain>50</Ieeel588_ Zone Multicast Domain>

Web Parameter Alternativ Domain Number

Default Value 0

Allowed Values Integer

Units Integer

Limits 0-127 digits

User or Admin Exposed in admin level

Description Zone Multicast Domain number to be used with the IEEE1588 Synchronisation.
Labels LAN Sync
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leee1588_Zone_Multicast_Ip

¥BX ML Tag Name
il

Teeel588_ Zone Multicast_ Ip

Example:

<Ieeel588 Zone Multicast Ip>224.0.1.129
</Ieeel588 Zone Multicast Ip>

Web Parameter

Multicast IP Address

Default Value 224.0.1.129
Allowed Values IP Address
Units IP Address
Limits IP Address

User or Admin

Exposed in admin level

Description Indicates the Zone multicast static IP list to use to communicate peer to peer.
The input format is IPv4: XXX.XXX.XXX.XXX
Labels LAN Sync

leee1588 Zone Multicast Port

¥BX ML Tag Name
il

Ieceel588 Zone Multicast Port

Example:

<Ieeel588_Zone Multicast Port>400</Ieeel588_ Zone Multicast Port>

‘Web Parameter

Multicast Port

Default Value 319

Allowed Values Integer

Units Integer

Limits 0-65535 digits

User or Admin

Exposed in admin level

Description

Indicates the Zone multicast port to use with the IEEE1588 Synchronisation.

Labels

LAN Sync
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INVITE_Expires

¥BX ML Tag Name INVITE Expires
il

Example:

<INVITE Expires>1800</INVITE Expires>

Web Parameter Session Timer Value (s)

Default Value 1800

Allowed Values Integer

Units Seconds

Limits 0-65535

User or Admin Exposed in admin level

Description Indicates the length of time in seconds for the SIP Session Timer.
Labels Servers

Language_Rule

Xllﬁ(ML Tag Name Language Rule
(i

Example:

<Language Rule>https://www.server.com/path/6825 mycustomtexts.xml</Language Rule>

Web Parameter Language Pack

Default Value None

Allowed Values URL

Units URL

Limits URL

User or Admin Exposed in admin level

Description Indicates the language file location for a handset update.
Labels Firmware Update
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Language_Selection

XML Tag Name handset Language
ifi®

Example:

<handset Language>Magyar</handset Language>

Web Parameter None

Default Value English

Allowed Values List of options

Units Options without units

Limits Option

User or Admin Exposed in user level
Description Defines the selected language
Labels None

LDAP Username

\BX ML Tag Name LDAP_Username
)
Example:
® <LDAP Username>CN=Dummy, OU=umber, DC=umber, DC=loc</LDAP_ Username>

* <LDAP Username>username</LDAP Username>

* <LDAP Username>user@domain</LDAP Username>

Web Parameter Bind

Default Value None

Allowed Values String

Units String

Limits 127 characters

User or Admin Exposed in admin level

Description Identifies the user name to use when the phone connects to the server.

Labels Central Directory




LDAP_Dir Enable

¥BX ML Tag Name LDAP Dir Enable
il

Example:

<LDAP Dir Enable>No</LDAP_Dir Enable>

Web Parameter

Central Directory Location

Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Indicates the use of LDAP directory.

Labels

Central Directory

LDAP_Display_Attrs

¥BXML Tag Name
i@

LDAP_Display Attrs

Example:

<LDAP_Display Attrs>a=cn,n=cn;a=givenName,n=firstname;a=sn,n=lastname;
a=telephoneNumber, n=telephoneNumber, t=p;a=homePhone, n=homePhone, t=p;a=mobile,
n=mobile, t=p;</LDAP Display Attrs>

Web Parameter

Name, Work, Home, and Mobile

Default Value a=cn,n=cn;a=givenName, n=firstname;a=sn,n=lastname;a=telephoneNumber,
n=telephoneNumber, t=p; a=homePhone, n=homePhone, t=p;a=mobile,n=mobile, t=p;

Allowed Values String

Units String

Limits 127 characters

User or Admin

Exposed in admin level
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Description Name: Indicates whether the common name or surname with the given name returns in the LDAP search
Work: Indicates LDAP work number attribute which maps to the handset work number.
Home: Indicates LDAP home number attribute which is maps to the handset home number.
Mobile: Indicates LDAP mobile number attribute which is maps to the handset mobile number.

Labels Central Directory

LDAP_First Name Filter

¥BX ML Tag Name
i

LDAP First Name Filter

Example:

<LDAP_First Name Filter>cn: (cn=John*)</LDAP First Name Filter>

Web Parameter LDAP Filter
Default Value None
Allowed Values String

Units String

Limits 127 characters

User or Admin

Exposed in admin level

Description

Identifies the search filter. For example, if the field is set to (| (givenName=%*) (sn=%%)),
the system uses this filter when it requests entries from the LDAP server. ¢ replaces
with the content which the user enters during the search operation. If a user enters J for
the search criteria, the string sent to the serveris (| (givenName=J*) (sn=J*)) and server
sends the matches for given names or surnames that start with the letter J.

Labels

Central Directory

LDAP Last Name_ Filter

¥BXML Tag Name
tfid

LDAP_Last Name Filter

Example:

<LDAP Last Name Filter>sn: (sn=L*)</LDAP Last Name Filter>

Web Parameter LDAP Filter
Default Value None
Allowed Values String
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Units

String

Limits

127 characters

User or Admin

Exposed in admin level

Description

Identifies the search filter. For example, if the field is set to (| (givenName=%%*) (sn=%%)),
the system uses this filter when it requests entries from the LDAP server. ¢ replaces
with the content which the user enters during the search operation. If a user enters J for
the search criteria, the string sent to the server is (| (givenName=J*) (sn=J*)) and server
sends the matches for given names or surnames that start with the letter J.

Labels

Central Directory

LDAP Password

¥BX ML Tag Name
i@

LDAP_ Password

Example:

<LDAP Password>passwrdl2</LDAP Password>

Web Parameter Password
Default Value None
Allowed Values String

Units String

Limits 127 characters

User or Admin

Exposed in admin level

Description

Contains the LDAP Server password.

Labels

Central Directory

LDAP Search Base

¥BX ML Tag Name
i@

LDAP_Search Base

Example:

<LDAP_ Search Base>dc=cv2bu,dc=com</LDAP Search Base>

Web Parameter Sbase
Default Value None
Allowed Values String
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Units String

Limits 127 characters

User or Admin Exposed in admin level

Description Identifies the search base criteria.
Example:

CN=Users, DC=number, DC=loc

Labels Central Directory

LDAP Server

¥BX ML Tag Name LDAP_ Server
i@

Example:

<LDAP_ Server>ldapserver.com</LDAP Server>

Web Parameter Server

Default Value None

Allowed Values String

Units String

Limits 127 characters

User or Admin Exposed in admin level

Description Identifies the server that contains the directory file.
Labels Central Directory

Ldap_Virtual_Lists

mﬁ(ML Tag Name Ldap_Virtual Lists
)

Example:

<Ldap Virtual Lists>Enabled</Ldap Virtual Lists>

Web Parameter Virtual List

Default Value Enabled




Allowed Values  Enabled

* Disabled
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Controls if virtual list search is possible.

* Disabled: All search results are loaded.

* Enabled: Only 25 contacts are loaded at a time.
Labels Central Directory

Line_Enable n_

\BX ML Tag Name
tfi®

Line Enable n_
Where nis 1 to 1000

Example:

<Line Enable 1 >Yes</Line Enable 1 >

Web Parameter None
Default Value Yes
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Indicates if an account is configured and active.
* Yes: The account is configured and active.
* No: The account isn't active.

Labels None
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Line Name n_

\BX ML Tag Name Line Name n_
il

Example:

<Line Name 1 >Test</Line Name 1 >

Web Parameter Line Name

Default Value None

Allowed Values String

Units String

Limits 7 characters

User or Admin Exposed in admin level

Description Indicates the short name for the extension when you use multiple lines.
Labels Extensions > Add or Edit Extension

LLDP

¥BX ML Tag Name LLDP
ufid Example:
<LLDP>No</LLDP>
Web Parameter LLDP-MED Send
Default Value No
Allowed Values * Yes
* No

Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Controls the use of Link Layer Discovery Protocol (LLDP) on the base.

If the value is ves, the base station sends 5 LLDP-MED messages after it starts.

Labels Network




LLDP_Delay

|t ML Tag Name LLDP_Delay
il

Example:

<LLDP Delay>30</LLDP Delay>

Web Parameter LLDP-MED Send Delay

Default Value 30

Allowed Values Integer

Units Seconds

Limits 0-255

User or Admin Exposed in admin level

Description Identifies the length of time, in seconds, that the device waits between LLDP-MED messages.
Note The parameter LLDP must be enabled to use this option.

Labels Network

Login_Password

Login_Password

¥BX ML Tag Name
il

Example:

<Login_ Password>Test123@</Login_ Password>

Web Parameter

XSI Password

Default Value None
Allowed Values String
Units String
Limits 128 characters

User or Admin

Exposed in admin level

Description

Identifies the password for the BroadSoft XSI phone book.

Labels

Extensions > Add or Edit Extension
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Login_User_ID

|t ML Tag Name Login_User_ID
nfid

Example:

<Login User ID>Testuser</Login User ID>

Web Parameter

XSI Username

Default Value None
Allowed Values String
Units String
Limits 128 characters

User or Admin

Exposed in admin level

Description

Identifies the username for the BroadSoft XSI phone book.

Labels

Extensions > Add or Edit Extension

Mailbox ID n_

¥BX ML Tag Name
il

Mailbox_ ID n_
Example:

<Mailbox ID 1 >Testmail</Mailbox ID 1 >

‘Web Parameter

Mailbox Name

Default Value None
Allowed Values String
Units String
Limits 39 characters

User or Admin

Exposed in admin level

Description Identifies the username for the voicemail system.
The SUBSCRIBE request uses this username, if specified, when subscribing to the Voice Mail
service.

Labels Extensions > Add or Edit Extension
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Management_Factory_Reset_From_Button

mﬁ(ML Tag Name Management Factory Reset From Button
iti®

Example:

<Management Factory Reset From Button>Enabled</Management Factory Reset From Button>

Web Parameter

Factory reset from button

Default Value Enabled

Allowed Values e Enabled
 Disabled

Units Options without units

Limits Option

User or Admin

Exposed in admin level

Description Indicates whether you can use the reset button to factory reset the base station. When set to Disabled,
nothing happens when you press the reset button.
Labels Management

MDNS_Support

¥BXML Tag Name

ufid

MDNS_Support
Example:

<MDNS_Support>No</MDNS_Support>

Web Parameter MDNS
Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Indicates if Multicast Domain Name System (MDNYS) is available.
DHCEP should be disabled to change this parameter.
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Labels Network

MediasSec_Over _TLS_Only_n_

¥BXML Tag Name MediasSec_Over TLS Only n_
i

Example:

<MediasSec Over TLS Only 1 >Disabled</MedissSec Over TLS Only 1 >

Web Parameter Media Security only for TLS
Default Value Disabled
Allowed Values * Enabled
* Disabled
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Controls the media security only if the SIP transfer protocol is TLS. This option can be

enabled only if the Media Security is enabled.

Labels Servers

MediaSec_Request_n_

Xﬂﬁ(ML Tag Name MediaSec Request n_
6fid

Example:

<MediaSec Request 1 >Enabled</MediaSec Request 1 >

Web Parameter Media Security
Default Value Disabled
Allowed Values * Enabled

* Disabled
Units Options without units
Limits Option
User or Admin Exposed in admin level
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Description Controls the media security.
* Enabled: Client-initiated Mode—The phone initiates media security negotiations.

* Disabled: Server-initiated Mode—The server initiates media security negotiations.
The phone doesn't initiate negotiations, but can handle negotiation requests from
the server to establish secure calls.

Labels Servers

NAT_Keep_Alive_Intvl

¥BX ML Tag Name NAT Keep Alive Intvl
ot

Example:

<NAT Keep Alive Intvl>90</NAT Keep Alive Intvl>

Web Parameter Keep alive time

Default Value 90

Allowed Values Integer

Units Seconds

Limits 0-65535

User or Admin Exposed in admin level

Description Determines the frequency of keep alive messages (in seconds) to the server to maintain NAT
bindings.

Labels Network

NetMask

|t ML Tag Name NetMask
i@

Example:

<NetMask>255.255.255.0</NetMask>

Web Parameter Subnet Mask
Default Value None
Allowed Values IP address
Units IP Address
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Limits

IP Address

User or Admin

Exposed in admin level

Description

Indicates the 32-bit subnet mask of the device. DHCP should be disabled to change this parameter.

Labels

Network

Network_Allow_Multi_Primary

¥BX ML Tag Name
il

Network Allow Multi Primary
Example:

<Network Allow Multi Primary>No</Network Allow Multi Primary>

‘Web Parameter

Allow multi primary

Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Allows the setup of one multicell in multiple locations.

Labels

Multi Cell

Network_Auto_Multi_Primary

¥BXML Tag Name
ifid

Network Auto Multi Primary
Example:

<Network Auto Multi Primary>No</Network Auto Multi Primary>

Web Parameter

Auto create multi primary

Default Value No
Allowed Values * Yes
* No
Units Options without units
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Limits Option

User or Admin Exposed in admin level
Description Indicates if you can auto configure multiple primary in a chain.
Labels Multi Cell

Network_Data_Config_Primary_Mac

¥BX ML Tag Name Network Data Config Primary Mac
ufib
b Example:

<Network Data Config Primary Mac>0C:75:BD:33:D5:01
</Network Data Config Primary Mac>

Web Parameter None

Default Value OxFFFFFFFFF

Allowed Values MAC address

Units MAC address

Limits MAC address

User or Admin Exposed in admin level

Description Specifies the MAC address of the base station which allows to download and handle

multicell configuration file.

Labels None

Network_Dect_Auto_Sync_Tree_Config

mﬁ(ML Tag Name Network Dect Auto Sync Tree Config
i

Example:

<Network Dect Auto Sync Tree Config>Yes</Network Dect Auto Sync Tree Config>

Web Parameter Auto configure DECT sync source tree
Default Value Yes
Allowed Values * Yes
* No
Units Options without units
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Limits

Option

User or Admin

Exposed in admin level

Description

Controls the ability to synchronize the multicell system.

* No—If the original primary base station can't be reached, the system continues
without a primary to sync to.

* Yes—If the original primary base station can't be reached, another base station
takes over as the primary base station.

Labels

Multi Cell

Network_Roaming_Deregister

¥BX ML Tag Name
i@

Network Roaming Deregister

Example:

<Network Roaming Deregister>No</Network Roaming Deregister>

Web Parameter

SIP Server support for multiple registrations per account

Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Defines the method to handle SIP registration when a handset roams between base
stations. Roam is the procedure when the handset moves its SIP and DECT registration
between base stations. The roaming can initiate when the handset is idle.

This parameter appears if the 210 Multi-Cell Base Station is in the multicell system.

* No—The SIP registration of the handset deregisters from the current base station
and registers to the new base station during roaming.

* Yes—The SIP registration of the handset remains on the current base station and
also registers to the new base station during roaming.

Labels

Multi Cell
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Network_Sntp_Broadcast_Enable

¥BX ML Tag Name Network Sntp Broadcast Enable
nfiB

Example:

<Network Sntp Broadcast Enable>Yes</Network Sntp Broadcast_ Enable>

Web Parameter

Allow broadcast NTP

Default Value Yes
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Identifies the use of the time server for all the devices.

Labels

Country

Network_Sync_Chain_Id

¥BXML Tag Name

fid

Network Sync Chain Id

Example:

<Network Sync Chain Id>512</Network Sync Chain Id>

Web Parameter

System chain ID

Default Value 512

Allowed Values Integer

Units Integer

Limits 0-4294967295 digits

User or Admin

Exposed in admin level

Description

Configures the Chain ID for dualcell system with DBS-110 or multicell system with
DBS-210. Each base station in a dualcell or multicell system uses the same Chain ID.

Note We recommend that you do not use a chain ID that is similar to an
extension number.
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Labels

Dual Cell or Multi Cell

Network_Sync_

Data_Transport

¥BXML Tag Name
i@

Network Sync_Data Transport
Example:

<Network Sync Data Transport>0</Network Sync Data Transport>

Web Parameter Data Sync
Default Value 0
Allowed Values * 0: Multicast

* 1: Peer-to-Peer
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Indicates the type of data synchronization.
* Multicast—Requires Multicast/IGMP to be enabled on the call control system.

* The multicast port range and IP addresses used is calculated from the chain
ID.

* The multicast feature uses the port range: 49200 to 49999.
* The multicast feature IP range: 224.1.0.0 to 225.1.0.0.
* Multicast uses UDP.
* Peer-to-peer—Use this mode when the network doesn't allow Multicast. For

multicast operation, enable the Multicast/IGMP on your switches. Otherwise, use
Peer-to-peer mode.

Labels

Dual Cell or Multi Cell

Network_Sync_Debug_Enable

\BX ML Tag Name
i@

Network Sync Debug Enable

Example:

<Network Sync Debug Enable>0</Network Sync Debug Enable>
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Web Parameter

Multi Cell debug

Default Value 0
Allowed Values * 0: None

* 1: Data Sync

* 2: Auto Tree

* 3: Both

* 4: iecee1588 debug
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Indicates the level of multicell debugging information that stores in the logs.

* 0: None—No data

* 1: Data Sync—Writes header information for all packets received and sent to use
to debug any special issues.

Note This setting generates many logs. Use it for a short period of time
when debugging.
* 2: Auto Tree—Writes states and data related to the Auto Tree Configuration feature.

* 3: Both—Both Data Sync and Auto Tree are enabled.

Note This setting generates many logs. Use it for a short period of time
when debugging.

* 4: icee1588 debug—Use only when ieee LAN sync is enabled.

Labels

Multi Cell

Network_Sync_Enable

¥BXML Tag Name
ifid

Network Sync Enable

Example:

<Network Sync Enable>No</Network Sync Enable>

Web Parameter

Multi Cell system or Dual Cell system

Default Value

No
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Allowed Values * Yes

* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Indicates if the base station is part of a dualcell or multicell configuration.

Labels

Dual Cell or Multi Cell

Network_Sync_Max_Sip_Reg_Per_Base

¥BXML Tag Name
ifid

Network Sync Max Sip Reg Per Base
Example:

<Network Sync Max Sip Reg Per Base>08</Network Sync Max Sip Reg Per Base>

Web Parameter

Number of SIP accounts before distributed load

Default Value 08
Allowed Values Integer
Units Integer
Limits 4-30 digits

User or Admin

Exposed in admin level

Description Defines when the base station attempts to distribute SIP registrations between the base stations in
the chain. If this parameter is set to the value 8, this base station attempts to distribute SIP
registrations to other base stations when it completes 8 SIP registrations.

Labels Multi Cell

Network_Sync_Primary_Static_Ip

¥BX ML Tag Name
il

Network Sync Primary Static Ip
Example:

<Network Sync Primary Static Ip>192.168.11.100</Network Sync Primary Static Ip>

Web Parameter

Primary Data Sync IP

Default Value

None
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Allowed Values IP address
Units IP address
Limits IP address

User or Admin

Exposed in admin level

Description

Indicates the base station data synchronization IP address.
When Data Sync is set to multicast, this base IP is selected automatically.
The data sync feature uses the port range of 49200 to 49999.

This option becomes available only if the parameter Network Sync Data Transport is setto 1
(Peer-to-peer)

Labels

Dual Cell or Multi Cell

Network_Sync_Time

¥BXML Tag Name
i@

Network Sync Time

Example:

<Network Sync Time>60</Network Sync Time>

‘Web Parameter

Synchronization time (s)

Default Value 60
Allowed Values Integer
Units Seconds
Limits 30-300

User or Admin

Exposed in admin level

Description Indicates the period in seconds between synchronization requests by the base stations
in the chain.
Labels Multi Cell

Network_Vlan_Synchronization

¥BXML Tag Name
i@

Network Vlan Synchronization

Example:

<Network Vlan Synchronization>Yes</Network Vlan Synchronization>
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Web Parameter

Synchronization

Default Value Yes
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Specifies if each base station can apply the VLAN settings to other base stations. This
parameter is specific to the base station and can't synchronize.
* Yes—All base stations use the same VLAN settings.
* No—Different VLAN settings on the base stations.
Labels Network

Network_Wan_Dhcp_Option_Plug_And_Play

¥BX ML Tag Name
i

Network Wan Dhcp Option Plug And Play

Example:

<Network_Wan_Dhcp_Option_Plug_And_Play>Yes</Network Wan_ Dhcp_Option_Plug And Play>

Web Parameter Plug-n-Play
Default Value Yes
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Indicates if the base automatically receives PBX IP addresses under DHCP option 120.
* Yes—Enables DHCP plug and Play. This enables to store DHCP option 120 as SIP server.
* No—Disables DHCP plug and Play.

Labels Network
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Number Of Base Stations

¥BX ML Tag Name Number Of Base Stations
nfiB

Example:

<Number Of Base Stations>50</Number Of Base Stations>

Web Parameter

System combination (Number of base stations/Repeaters per base station)

Default Value 50
Allowed Values * 50
* 127
* 254
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description The three settings of base stations/repeaters per base station available are 50/3, 127/1,
and 254/0.
Labels Multi Cell

Off_Hook_Warning_Tone

¥BX ML Tag Name
i

Off Hook Warning_ Tone

Example:

<Off Hook Warning Tone>480@10,620@0;10(.125/.125/1+2)
</0ff_ Hook Warning Tone>

Web Parameter

Off Hook Warning Tone

Default Value 480@10,620@0;10(.125/.125/1+2)
Allowed Values String

Units String

Limits 256 characters

User or Admin

Exposed in admin level

Description

Indicates the tone to play when the phone receiver is off hook after a period of time.

Labels

Call Progress Tones
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Outbound_Proxy n_

\BX ML Tag Name Outbound Proxy n_
ofi®

Example:

<Outbound Proxy 1 >outboundproxy.com</Outbound Proxy 1 >

Web Parameter

Outbound Proxy

Default Value None
Allowed Values Server URL
Units URL

Limits 63 characters

User or Admin

Exposed in admin level

Description Identifies the Session Border Controller or SIP server outbound proxy.
Set the outbound proxy to the address and port of the private NAT gateway, so that SIP
messages are sent through the NAT gateway.
Labels Servers
Page_Tone
\BX ML Tag Name Page Tone
ofi®

Example:

<Page Tone>600@-16;.3(.05/0.05/1)</Page Tone>

‘Web Parameter

Page Tone

Default Value 600@-16;.3(.05/0.05/1)
Allowed Values String

Units String

Limits 256 characters

User or Admin

Exposed in admin level

Description

Indicates the tone to play to all handsets when the base station receive a page.

Labels

Call Progress Tones
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Password n_

¥BX ML Tag Name Password n_
i

Example:

<Password 1 >Testpwd</Password 1 >

Web Parameter Authentication Password

Default Value None

Allowed Values String

Units String

Limits 128 characters

User or Admin Exposed in admin level

Description Identifies the user's password on the call control system.
Labels Extensions > Add or Edit Extension

Phone_ Name

¥BX ML Tag Name Phone_Name
il

Example:

<Phone Name>abcdstation</Phone_ Name>

Web Parameter Base Station Name

Default Value SME VoIP

Allowed Values String

Units String

Limits 35 characters

User or Admin Exposed in admin level

Description Indicates the name of the base station.
Labels Management
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Phonebook Filename

¥BX ML Tag Name Phonebook Filename
ifi®

Example:

<Phonebook Filename>abcphonebook</Phonebook Filename>

Web Parameter Filename

Default Value None

Allowed Values String

Units String

Limits 31 characters

User or Admin Exposed in admin level

Description Identifies the name of the directory file on the server.
Labels Central Directory

Phonebook Location

¥BX ML Tag Name Phonebook Location
utiB

Example:

<Phonebook Location>192.168.10.11</Phonebook Location>

Web Parameter Server

Default Value None

Allowed Values IP address

Units IP address

Limits IP address

User or Admin Exposed in admin level

Description Identifies the server that contains the directory.

Labels Central Directory




Phonebook Reload Time

¥BX ML Tag Name Phonebook Reload Time
ifi®

Example:

<Phonebook_Reload Time>250</Phonebook_ Reload Time>

Web Parameter Phonebook reload interval(s)

Default Value 0

Allowed Values Integer

Units Seconds

Limits 0-4294967295

User or Admin Exposed in admin level

Description Controls how often the base station refreshes the phonebook contents in seconds. The refresh

doesn't happen when the field is set to 0.

Specify a time that is frequent enough for the users but not so frequent that it overloads the base
station.

Labels Central Directory

Phonebook Server Location

¥BX ML Tag Name Phonebook Server Location
ofid

Example:

<Phonebook Server Location>0</Phonebook Server Location>

Web Parameter Central Directory Location
Default Value 0
Allowed Values *0
e 1
2
Units Options without units
Limits Option
User or Admin Exposed in admin level
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Description Identifies the type of central directory:
* 0: Local—Indicates the use of an imported comma separated value (CSV) file.
* 1: LDAP Server—Indicates the use of an LDAP directory.
* 2: XSI Server—Indicates the use of Broadworks Directory.

Labels Central Directory

Pnp_Config

¥BXML Tag Name
ifid

Pnp Config
Example:

<Pnp Config>On</Pnp Config>

Web Parameter None
Default Value On
Allowed Values * On
 Off
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Indicates if a possible provider specific PnP registration feature is enabled.

Labels

None

Preferred Codec n_

\BX ML Tag Name
i@

Preferred Codec n_

Example:

<Preferred Codec 1 >G722</Preferred Codec 1 >

Web Parameter

Codec Priority

Default Value

PCMU
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Allowed Values « PCMU
* PCMA
* G726
» G722
* G729
* OPUS

Units Options without units

Limits Option

User or Admin Exposed in admin level

Description Identifies the code priority that base stations use for audio compression and transmission. You can
change the order of the codecs.

To get OPUS to display in the list, click Reset Codecs. If you change the list in any way, you must
set the Reset Codecs and Reboot chain.

Labels Servers

Primary_DNS

¥BXML Tag Name Primary_ DNS
upid Example:

<Primary DNS$>192.168.10.10</Primary DNS>

Web Parameter DNS (Primary)

Default Value None

Allowed Values IP address

Units IP address

Limits IP address

User or Admin Exposed in admin level

Description Indicates the use of [Pv4 address of the main server for Domain Name System (DNS) queries.

This parameter is mandatory when you don't use DHCP.

Labels Network
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Primary_NTP_Server

mﬁ(ML Tag Name Primary NTP Server
itid

Example:

<Primary NTP Server>192.168.10.28</Primary NTP Server>

Web Parameter Time Server

Default Value None

Allowed Values IP Address

Units IP Address

Limits IP Address

User or Admin Exposed in admin level

Description Identifies the DNS name or the IP address of the network time server.
Note Only IPv4 addresses are supported.

Labels Country

Profile Rule

XML Tag Name Profile Rule
tid

Example:

<Profile Rule>https://ciscoserver.com</Profile Rule>

Web Parameter Configuration Server Address
Default Value Empty

Allowed Values Server URL

Units URL

Limits URL

User or Admin Exposed in admin level
Description Defines the profile URL.
Labels Management
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Promiscuous_button_enabled

XML Tag Name Promiscuous button enabled
ifi®

Example:

<Promiscuous_button_enabled>No</Promiscuous_button_enabled>

Web Parameter None
Default Value None
Allowed Values * Yes
* No
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Allows you to reset the base station to factory defaults and then enable the promiscuous
mode.
Labels None

Promiscuous _mode

Mﬁ(ML Tag Name Promiscuous_mode
tfid

Example:

<Promiscuous_mode>2</Promiscuous_mode>

Web Parameter Enable in (min)

Default Value None

Allowed Values Integer

Units Minutes

Limits 0-255 digits

User or Admin Exposed in admin level

Description Indicates the time for the base station in promiscuous mode.
Labels Management
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Prompt_Tone

XML Tag Name Prompt Tone
i

Example:

<Prompt Tone>520@-19,620€-19;10(*/0/1+2)</Prompt Tone>

Web Parameter Prompt Tone
Default Value 520@-19,620@-19;10(*/0/1+2)
Allowed Values String
Units String
Limits 256 characters
User or Admin Exposed in admin level
Description Prompts the user to enter a call forwarding phone number.
Labels Call Progress Tones
Proxy_n_

\BX ML Tag Name Proxy n_

ufid Example:

<Proxy 1 >192.168.10.11</Proxy 1 >

Web Parameter Registrar

Default Value None

Allowed Values IP address

Units IP address

Limits IP address

User or Admin Exposed in admin level

Description Identifies the SIP Server (call control system) proxy server.

The port number in the address is optional.

Labels Servers
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PRT_http_header

mﬁ(ML Tag Name PRT http header
itid

Example:

<PRT_http header>Last-Modified</PRT_http_header>

Web Parameter PRT Upload HTTP Header

Default Value None

Allowed Values String

Units String

Limits 63 characters

User or Admin Exposed in admin level

Description Specifies a header for the HTTP upload request. This field is optional.

If you specify the header, you must specify a value in PRT http header value.

Labels Management

PRT_http_header_value

B ML Tag Name PRT http header value
ufib

Example:

<PRT_http header value>Mon, 6 Dec 2021 13:45:00 GMT</PRT_http header value>

Web Parameter PRT Upload HTTP Header Value

Default Value None

Allowed Values String

Units String

Limits 127 characters

User or Admin Exposed in admin level

Description Indicates the header field value for HTTP upload request. You must specify the header

text in PRT http header.

Labels Management
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PRT_upload_filename

PRT_upload_filename

¥BX ML Tag Name
il

Examples:

<PRT upload filename>Hello.tar.gz</PRT upload filename>
<PRT_upload filename>Mac$MAC.tar.gz</PRT_upload filename>

<PRT upload filename>path/path2/Mac$MAC.tar.gz</PRT upload filename>

Web Parameter

PRT Upload Filename

Default Value None
Allowed Values String
Units String
Limits 64 characters

User or Admin

Exposed in admin level

Description

Indicates the problem report filename. The file extension is tar.gz.

Labels

Management

PRT_upload_server

¥BXML Tag Name
i@

PRT_upload_server
Example:

<PRT upload server>https://ciscoprtserver.com:443</PRT upload server>

Web Parameter

PRT Upload Server

Default Value Empty
Allowed Values URL

Units URL

Limits 127 characters

User or Admin

Exposed in admin level

Description

Indicates the target server to upload the problem report.

Labels

Management
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Reg_Retry_Intvl_n_

¥BX ML Tag Name Reg Retry Intvl n
i

Example:

<Reg Retry Intvl 1 >30</Reg Retry Intvl 1 >

Web Parameter Registration Retry Interval

Default Value 30

Allowed Values Integer

Units Seconds

Limits 0-4294967295 digits

User or Admin Exposed in admin level

Description Identifies the time in seconds to wait before the handset retries registration after a failed registration.

Use this parameter when the registration failure message is Retry Reg RSC.

Labels Servers

Reg_Retry_Intvl_High_Rnd

\BX ML Tag Name Reg Retry Intvl High Rnd
ofid

Example:

<Reg Retry Intvl High Rnd>30</Reg Retry Intvl High Rnd>

Web Parameter Registration Retry Interval High Rnd

Default Value 30

Allowed Values Integer

Units Integer

Limits 1-2147483

User or Admin Exposed in admin level

Description Indicates the high value of random interval to wait before registration retry after failing

the last registration. If this value is greater than Reg Retry Intvl n , a random value
between these two values is chosen.

Labels Server
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Reg_Retry_Long_Intvl_n_

¥BX ML Tag Name Reg Retry Long Intvl n
i

Example:

<Reg_Retry Long Intvl 1 >1500</Reg_Retry Long Intvl 1 >

Web Parameter Registration Retry Interval Long

Default Value 1200

Allowed Values Integer

Units Seconds

Limits 0-4294967295

User or Admin Exposed in admin level

Description Identifies the time in seconds to wait before the handset retries registration after a failed

registration. Use this parameter when the registration failure message is something other
than Retry Reg RSC.

If the field is set to 0, the handset doesn't retry the registration.

Set this parameter a larger interval than the value in Reg Retry Intvl n .

Labels Servers

Reg_Retry_Long_Intvl_High_Rnd

B ML Tag Name Reg Retry Long Intvl High Rnd
tid

Example:

<Reg_Retry Long Intvl High Rnd>1200</Reg_Retry Long_ Intvl High Rnd>

Web Parameter Registration Retry Long Interval High Rnd
Default Value 1200

Allowed Values Integer

Units Integer

Limits 1-2147483

User or Admin Exposed in admin level
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Description High value of random long interval to wait before registration long interval retry. If
RegistrationRetry Long Interval High Rnd is greater than RegistrationRetry
IntervalLong, then a random value between these two values is used. If the value is
less than or equal to RegistrationRetry IntervalLong, then RegistrationRetry
IntervallLong is used.

Labels Server

Register_Expires_n_

Xﬂﬁ(ML Tag Name Register Expires n
i

Example:

<Register Expires_1 >4000</Register Expires 1 >

‘Web Parameter

Reregistration time (s)

Default Value 3600
Allowed Values Integer
Units Seconds
Limits 0-65535

User or Admin

Exposed in admin level

Description Indicates the time in seconds for a valid SIP registration and represents the maximum
time between SIP registrations for the SIP account.
We recommend that you don't set this below 60 seconds.
Labels Servers
Reorder_Tone
B ML Tag Name Reorder Tone
ufid Example:

<Reorder Tone>480@-19,6206€-19;10(.25/.25/1+2)</Reorder Tone>

Web Parameter

Reorder Tone

Default Value 480@-19,620@-19;10(.25/.25/1+2)
Allowed Values String
Units String
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Limits

256 characters

User or Admin

Exposed in admin level

Description Plays when an outbound call fails or after the far end hangs up during an established
call. Reorder Tone plays automatically when Dial Tone or any of its alternatives times
out.

Labels Call Progress Tones

Repeater_Auto_Config_Mode_n_

¥BX ML Tag Name
il

Repeater Auto Config Mode n
Example:

<Repeater Auto Config Mode 1 >1</Repeater Auto Config Mode 1 >

Web Parameter DECT sync mode
Default Value 1
Allowed Values * 0: Manual
* 1: Local Automatically
* 2: Chaining Automatically
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Indicates the type of synchronisation with the base station.
* 0: Manual—Manually specify REPEATER RPN and REPEATER SYNC SRC RPN.

* 1: Local Automatically—Repeater searches for available base stations and automatically
locate the nearest base station. If a base station is turned off, the repeater tries to locate another
available base station. The settings REPEATER RPN and REPEATER SYNC SRC RPN
are ignored.

* 2: Chaining Automatically—All base stations and repeaters send a RSSI report to the primary
base station. The primary base station uses the report to create a new DECT synchronization
tree with all the selected base stations and repeaters to use this setting.

Labels

Repeaters
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Repeater_Data_Configured_n_

¥BX ML Tag Name Repeater Data Configured n_
ifi®

Example:

<Repeater Data Configured 1 >Yes</Repeater Data Configured 1 >

Web Parameter State
Default Value Yes
Allowed Values * Yes
* No
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Indicates the state of the repeater.

* No—The repeater isn't configured to communicate with the base.

* Yes—The repeater is configured to communicate with the base.

Labels Repeater

Repeater_Dect_lpui_n_

X ML Tag Name Repeater Dect Ipui n_
nfi

Example:

<Repeater Dect Ipui 1 >0xAABB1212FF</Repeater Dect Ipui 1 >

Web Parameter None

Default Value OxFFFFFFFFFF
Allowed Values Hexadecimal

Units Hexadecimal

Limits 12 characters

User or Admin Exposed in admin level
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Description

Indicates the repeater International Portable User Identity (IPUI). You can't configure the IPUI
with provisioning. You can specify the IPUI as HEX strings containing 10 HEX values available
in the repeater status menu.

You can provision without 0x in the value.

Note A IPEI/IPUI value must be available only once in the configuration file.

Labels

None

Repeater_Name_n_

¥BX ML Tag Name
i

Repeater Name n
Example:

<Repeater Name 1 >Repeatername</Repeater Name 1 >

Web Parameter Name
Default Value None
Allowed Values String

Units String
Limits 19 characters

User or Admin

Exposed in admin level

Description

Identifies the repeater name. You might want to set the name to a location.

Labels

Repeaters > Add or Edit Repeaters

Repeater_Rpn_n_

¥BXML Tag Name
i

Repeater Rpn n_
Example:
<Repeater Rpn 1 >0x00</Repeater Rpn 1 >

<Repeater Rpn 2 >0x0l</Repeater Rpn 2 >

Web Parameter

None

Default Value

0x00
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Allowed Values * 0x00

» 0x01
» 0x02
* 0x03
Units Hexadecimal
Limits 0-255
User or Admin Exposed in admin level
Description Use this parameter when Repeater Auto Config Mode is set to manual.

You can specify a unique RPN value with the parameter Repeater Sync Src Rpn for each repeater.

The repeaters use only the number of bits of the RPNs 8 bits for this parameter. The number of
bits that repeater RPN uses is 2.

You must configure all the repeaters that use manual mode to use unique RPN.

The RPN value 0x00 of the base station is invalid.

Labels None

Repeater_Sync_Src_Rpn_n_

¥BX ML Tag Name Repeater Sync Src Rpn n_
apd Example:

<Repeater Sync Src Rpn 1 >0x00</Repeater Sync Src Rpn 1 >

Web Parameter None

Default Value 0x00

Allowed Values Hexadecimal

Units Hexadecimal

Limits 1-252 digits

User or Admin Exposed in admin level
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Description Use this parameter when Repeater Auto Config Mode is set to manual.
You can specify a unique RPN value with the parameter REPEATER RPN for each repeater.
The maximum chain length is 3 repeaters in the chain for a base Station.
You must configure all the repeaters which use the manual mode to use unique RPN.

RPN 0x01 to 0x03 uses the base station in NETWORK SYNC MAC CHAIN index 0 as the DECT
synchronization source. RPN 0x04 to 0x06 uses the base station in NETWORK_SYNC_MAC CHAIN index
1 as the DECT synchronization source.

Labels None

Resync_At_ HHmm_

XX ML Tag Name Resync_ At HHmm
ifi®

Example:

<Resync At HHmm >14:05</Resync At HHmm >

Web Parameter Auto Resync Time

Default Value 00:00

Allowed Values String

Units hh:mm format

Limits 23:59

User or Admin Exposed in admin level

Description Indicates the time (24-hour clock) that the base station looks to resync the configuration file.

The value is in the format 00h00 in French and Spanish configuration files.

Labels Management

Resync_At_Random_Delay

xtnBx ML Tag Name Resync_At Random Delay
tfi®

Example:

<Resync_At Random Delay>20</Resync_ At Random Delay>

Web Parameter Auto Resync Max Delay (Min)
Default Value 15
Allowed Values Integer
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Units Seconds

Limits 0-1439
User or Admin Exposed in admin level
Description Indicates the time delay, in seconds. Set different delay times for each base station to prevent them

from asking for new configuration files at the same time.

Use this parameter with Auto Resync_Time, Auto Resync_Polling, Auto Resync Periodic,
Auto_Resync Days.

Labels Management

Resync_Periodic

mﬁ(ML Tag Name Resync_Periodic
i@

Example:

<Resync_Periodic>500</Resync Periodic>

Web Parameter Auto Resync Periodic (Min)
Default Value 0

Allowed Values Integer

Units Minutes

Limits 0-65535

User or Admin Exposed in admin level

Description Indicates the resync time in minutes.

Use this parameter with Auto Resync_ Time, Auto _Resync_ Polling, Auto Resync_Delay, and
Auto_ Resync_Days.

Labels Management

Resync_Polling

\tnBX ML Tag Name Resync_Polling
i

Example:

<Resync Polling>0ff</Resync Polling>

Web Parameter Auto Resync Polling

Default Value Off
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Allowed Values * On

* Off
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Controls the ability to look for new configuration files for the automatic synchronization. If the
value is on, automatic sync is enabled.
Use this parameter with Auto Resync Time, Auto Resync Periodic, Auto Resync Delay,
Auto_Resync_Days,and,Auto resync configuration polling.

Labels Management

Retry Reg_RSC_n_

¥BXML Tag Name
ifid

Retry Reg RSC n_
Example:

<Retry Reg RSC_1 >52?,6??</Retry Reg RSC_ 1 >

Web Parameter

Registration Retry RSC

Default Value None
Allowed Values String
Units String
Limits 15 characters

User or Admin

Exposed in admin level

Description Identifies the Response SIP Code (RSC) that triggers a retry. You can set up to 4 comma-delimited
values and use the wild card character (?).
If SIP response code to a register attempt matches this filter, it uses
SRV_SIP_REGISTER RETRY INTERVAL.Otherwise,ituses SRV _SIP REGISTER RETRY LONG INTERVAL.
Labels Servers

115



Reversed Auth Realm n_

¥BX ML Tag Name Reversed Auth Realm n_
i

Example:

<Reversed Auth Realm 4 >Broadworks</Reversed Auth Realm 4 >

Web Parameter Reversed Auth Realm
Default Value None
Allowed Values * Enabled
* Disabled
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Indicates the IP address for an authentication realm other than the proxy IP address.
Labels Servers

Reverse_Phone_Lookup_Serv

Mﬁ(ML Tag Name Reverse Phone_ Lookup_ Serv
Gfid

Example:

<Reverse Phone Lookup Serv>No</Reverse Phone Lookup Serv>

Web Parameter None
Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option
User or Admin Exposed in admin level.
Description * Yes: Enabled—If you define a central directory, the lookup in central directory is done.

* No: Disabled— If you define a central directory, the lookup in central directory isn't done.
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Labels None

RFC 2543 Call Hold n_

|t ML Tag Name RFC_2543 Call Hold n_
i@

Example:

<RFC_2543_Call_Hold n_>Yes</RFC_2543_Call Hold_n_>

Web Parameter Hold Behaviour
Default Value Yes
Allowed Values * Yes
* No
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Indicates the way hold works on the handset.

* Yes—The connection information part of the SDP is set to 0.0.0.0, and based on
the context the direction attribute is send only, recvonly, or inactive.

* No—Behaves according to RFC 3264. The connection information part of the SDP
contains the IP address of the endpoint, and based on the context the direction
attribute is send only, recvonly, or inactive.

Labels Servers

Ring_Back_Tone

¥nBXML Tag Name Ring Back Tone
i

Example:

<Ring_Back Tone>440@-19,480@-19;*(2/4/1+2)</Ring Back_Tone>

Web Parameter Ring Back Tone

Default Value 440@-19,480@-19;*(2/4/1+2)
Allowed Values String

Units String
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Limits 256 characters

User or Admin Exposed in admin level
Description Indicates the tone that plays during an outbound call when the far end is ringing.
Labels Call Progress Tones

Rsx_ Trace Internal

XML Tag Name Rsx_Trace Internal
tid

Example:

<Rsx Trace Internal>0</Rsx Trace Internal>

Web Parameter RSX internal tracing
Default Value 0
Allowed Values * 0: Disabled
* 1: Enabled
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Indicates if internal tracing is Disabled or Enabled. You can enable this parameter for
debugging.
Labels Diagnostics

Rtp_Collision_Control

M&ML Tag Name Rtp Collision Control
apd Example:

<Rtp Collision Control>Enabled</Rtp Collision Control>

Web Parameter RTP Collision Detection
Default Value Enabled
Allowed Values * Enabled

* Disabled
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Units

Options without units

Limits

Option

User or Admin

Exposed in admin level

Description Allows to enable or disable RTP collision control.

* Enabled—The device accepts all sources.

* Disabled—When two sources have the same SSRC, the second source is discarded.
Labels Network

RTP_Packet Size n_

¥BX ML Tag Name
i

RTP_Packet Size n_
Example:

<RTP_Packet Size 1 >0.020</RTP_Packet Size 1 >

Web Parameter

RTP Packet Size

Default Value 0.020

Allowed Values + 0.020
* 0.040
+ 0.060
+ 0.080

Units ms

Limits 0.020-0.080

User or Admin

Exposed in admin level

Description

Indicates the preferred RTP packet size when the packet size is negotiated.

Labels

Servers

RTP_Port Max

\BX ML Tag Name
i@

RTP_Port Max

Example:

<RTP_Port Max>16423</RTP_Port Max>
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Web Parameter

RTP Port Range

Default Value 16423
Allowed Values Integer

Units Integer

Limits 0-65280 digits

User or Admin

Exposed in admin level

Description Indicates the number of ports to use for RTP audio streaming.
Labels Network
RTP_Port_Min

\BX ML Tag Name RTP_Port Min

apd Example:

<RTP_Port Min>16384</RTP_Port Min>

Web Parameter RTP port
Default Value 16384
Allowed Values Integer
Units Integer
Limits 0-65280

User or Admin

Exposed in admin level

Description

Indicates the first RTP port to use for RTP audio streaming.

Labels

Network

RTP_TOS DiffServ Value

¥BXML Tag Name
tfid

RTP_TOS DiffServ Value
Example:

<RTP_TOS_DiffServ_Value>0xb8</RTP_TOS DiffServ_Value>

Web Parameter

RTP ToS/QoS

Default Value

0xb8
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Allowed Values Hexadecimal

Units Hexadecimal

Limits 0-254

User or Admin Exposed in admin level

Description Indicates the priority of RTP traffic, based on the IP layer Type of Service (ToS) byte.

* Bits 7-5 define precedence
* Bits 4-2 define ToS

* Bits 1-0 are ignored

Note The cost bit is not supported.

Labels Network

Second_Preferred Codec n

\BX ML Tag Name Second_Preferred Codec n_
nfid

Example:

<Second Preferred Codec 1 >G722</Second Preferred Codec 1 >

Web Parameter Codec Priority

Max number of codecs is 5

Default Value G722
Allowed Values * PCMU

* PCMA

* G726

* G722

* G729

* OPUS
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Identifies the code priority that base stations use for audio compression and transmission.

You can change the order of the codecs.
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Labels Servers

Secondary_DNS

Mﬁ(ML Tag Name Secondary DNS
i

Example:

<Secondary DNS>192.168.10.11</Secondary DNS>

Web Parameter DNS (Secondaries)

Default Value None

Allowed Values IP address

Units IP address

Limits IP address

User or Admin Exposed in admin level
Description Indicates the alternate DNS server.

You must enable DHCP to change this parameter.

Labels Network

Secure_Call_Option_n_

X ML Tag Name Secure Call Option n_
upd Example:

<Secure Call Option 1 >Disabled</Secure Call Option 1 >

Web Parameter Secure RTP
Default Value Disabled
Allowed Values * Disabled
* Enabled
* Optional
* Auto
Units Options without units
Limits Option
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User or Admin Exposed in admin level

Description Indicates if RTP streams are encrypted.

* Disabled—Indicates that the RTP stream isn't encrypted. The SRTP is disabled
and the calls that require SRTP are rejected.

* Enabled—Indicates that the RTP stream is encrypted. The calls that don't support
SRTP are rejected.

* Optional—Indicates that the RTP encryption is optional. The SDP contains AVP
and SAVP profiles. Both the SRTP supported and not supported calls are accepted.

* Auto—The media security defines if the protocol is RTP or SRTP.

Labels Servers

Secure_Call_Setting_n_

|t ML Tag Name Secure Call Setting n_
ofid

Example:

<Secure_Call_setting 1 >Yes</Secure_Call_Setting 1 >

Web Parameter Secure RTP Auth
Default Value Yes
Allowed Values * Yes
* No
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Indicates if secure RTP uses authentication of RTP packets. When enabled, a base can

support a maximum of 4 concurrent calls.

* Yes: Enabled—Authentication is enabled in SRTP stream.

* No: Disabled—Authentication is disabled in SRTP stream.

Labels Servers
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Server ID n_

\BX ML Tag Name Server ID n_
ofi®

Example:

<Server ID 1 >1</Server ID 1 >

Web Parameter Server

Default Value 1

Allowed Values Integer

Units Integer

Limits 1-10 digits

User or Admin Exposed in admin level

Description Identifies the SIP server address of the call control system.
Labels Extensions > Add or Edit Extension

Share_Call_Appearance_n_

|t ML Tag Name Share_Call_Appearance_n_
ofid

Example:

<Share Call Appearance_ 1 >Private</Share Call Appearance 1 >

Web Parameter BroadWorks Shared Call Appearance
Default Value Private
Allowed Values * Private
* Shared
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Identifies if the line is shared.

Only applicable to BroadSoft SIP servers. Must be enabled on the SIP server. If the
value is Private, the extension isn't part of a shared call appearance.

Labels Extensions > Add or Edit Extension
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SIP_100REL_Enable n_

XML Tag Name SIP_100REL Enable n
i

Example:

<SIP_100REL Enable 1 >Yes</SIP_100REL Enable 1 >

Web Parameter Supported 100rel
Default Value Yes
Allowed Values * Yes
* No
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Allows to add a supported header that contains 100rel to the SIP message when you

send an outgoing INVITE request. The base station supports PRACK requests. If the
value is Yes, it allows to add 100rel in Supported header in the outgoing INVITE SIP
request.

Labels Servers

Sip_Check_Sync_Always_Reboot

mﬁ(ML Tag Name Sip Check Sync Always Reboot
i@

Example:

<Sip Check Sync Always_ Reboot>On</Sip Check Sync Always_Reboot>

Web Parameter Always Reboot On Check-Sync
Default Value Disabled
Allowed Values * On
« Off
Units Options without units
Limits Option
User or Admin Exposed in admin level
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Description Indicates if the base station reboots when a NOTIFY of the type check-sync is sent to
the base station.
Labels Network

Sip_Failover_Reconnect_Timer

¥BX ML Tag Name
i

Sip Failover Reconnect Timer

Example:

<Sip Failover Reconnect Timer>60</Sip Failover Reconnect Timer>

Web Parameter

Failover Reconnect Timer

Default Value 60
Allowed Values Integer
Units Seconds
Limits 0-4294967

User or Admin

Exposed in admin level

Description Controls the delay, in seconds, between queries from the base station to locate the primary server
during failover.
Labels Network

SIP_Qutbound_Proxy_Mode

¥BXML Tag Name
i

SIP Outbound Proxy Mode

Example:

<SIP Outbound Proxy Mode>0</SIP Outbound Proxy Mode>

Web Parameter

Outbound Proxy Mode

Default Value 0
Allowed Values * 0: Use Always
* 1: Only use Outbound Proxy for initial SIP requests
Units Options without units
Limits Option

User or Admin

Exposed in admin level
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Description Indicates the outbound proxy use.
* 0: Use always—All outbound calls as sent to the outbound proxy.
¢ 1: Only use Outbound Proxy for initial SIP requests—Only use the outbound proxy
for initial SIP requests.
Labels Network
SIP_Port
\BX ML Tag Name SIP Port
ufid Example:

<SIP_Port>5060</SIP_Port>

Web Parameter

Local SIP Port

Default Value 5060

Allowed Values Integer

Units Integer

Limits 0-65280 digits

User or Admin

Exposed in admin level

Description

Indicates the SIP signaling source port.

Labels

Network

Sip_Reject_Anonymous_Calls_Enabled_n

¥BX ML Tag Name
i@

Sip Reject Anonymous_Calls Enabled n
Example:

<Sip_Reject Anonymous_Calls Enabled 1>Disabled
</Sip Reject Anonymous Calls Enabled 1>

‘Web Parameter

Reject Anonymous Calls

Default Value Disabled
Allowed Values * Enabled
* Disabled
Units Options without units
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Limits

Option

User or Admin

Exposed in admin level

Description

Indicates if the handset should reject calls that don't have a caller ID.

Labels

Extensions > Add or Edit Extension

Sip_Stun_Bindtime_Determine

¥BX ML Tag Name
i

Sip Stun Bindtime Determine

Example:

<Sip Stun Bindtime Determine>On</Sip Stun Bindtime Determine>

Web Parameter

STUN Bindtime Determine

Default Value On
Allowed Values * On
* Yes
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description If sTun is enabled and you define sTp_STUN BINDTIME GUARD, setting this parameter to on forces
the system to automatically determine the duration of NAT bindings in the system. The
SIP STUN BINDTIME GUARD parameter defines the initial test duration.

Labels Network

Sip_Stun_Bindtime_Guard

¥BXML Tag Name
ifid

Sip_Stun Bindtime Guard

Example:

<Sip Stun Bindtime Guard>80</Sip Stun Bindtime Guard>

Web Parameter

STUN Bindtime Guard

Default Value 80
Allowed Values Integer
Units Seconds
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Limits 0-65535

User or Admin Exposed in admin level
Description Identifies the lifetime of the STUN binding.
Labels Network

Sip_Timer_B

|t ML Tag Name Sip Timer B
ofi

Example:

<Sip Timer B>5</Sip Timer B>

Web Parameter Failover SIP timer B

Default Value 5

Allowed Values Integer

Units Seconds

Limits 0-4294967

User or Admin Exposed in admin level

Description Indicates the time to wait for a response from an INVITE message from the SIP server

before failover is triggered.

Labels Network

Sip_Timer_F

\tBX ML Tag Name Sip Timer F
ofi

Example:

<Sip Timer F>5</Sip Timer F>

Web Parameter Failover SIP Timer F
Default Value 5

Allowed Values Integer

Units Seconds

Limits 0-4294967
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User or Admin

Exposed in admin level

Description Indicates the time to wait for a response from an non-INVITE message from the SIP
server before failover is triggered.
Labels Network

SIP_TOS DiffServ_value

¥BXML Tag Name
ifid

SIP_TOS DiffServ_value

Example:

<SIP_TOS_DiffServ_value>0x68</SIP_TOS DiffServ_value>

Web Parameter SIP ToS/QoS
Default Value 0x68
Allowed Values Hexadecimal
Units Hexadecimal
Limits 0-254

User or Admin

Exposed in admin level

Description

Indicates the priority of call control signaling traffic that is based on the IP layer Type
of Service (ToS) byte. ToS is the same as Quality of Service (QoS) in packet-based
networks.

* Bits 7-5 defines precedence
* Bits 4-2 defines Type of Service

* Bits 1-0 are ignored

Note The cost bit isn't supported.

Labels

Network

SIP_Transport_n_

¥BXML Tag Name
itiB

SIP Transport n_

Example:

<SIP Transport 1 >UDP</SIP Transport 1 >

Web Parameter

SIP Transport
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Default Value UDP

Allowed Values « UDP
* TCP
* TLS
 Auto
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Indicates the protocol for SIP transport.

« UDP— Enforce the use of SIP over UDP.
e TCP—Enforce the use of SIP over TCP.
* TLS—Enforce the use of TLS over TCP.

* Auto—A NAPTR lookup must succeed. The order (normally TLS, TCP, UDP) of
the entries from the DNS NAPTR lookup is taken into account. TLS, TCP, and
UDP are all accepted. SCTP is not accepted.

Labels Servers

Sip_Use_Different_Ports

¥BXML Tag Name Sip Use Different Ports
i

Example:

<Sip Use Different Ports>Disabled</Sip Use Different Ports>

Web Parameter Use Different SIP Ports
Default Value Disabled
Allowed Values * Enabled

* Disabled
Units Options without units
Limits Option
User or Admin Exposed in admin level
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Description

Indicates SIP signaling ports.

* Disabled—The Local SIP Port field specifies the source port used for SIP signaling
in the system.

* Enabled—The Local SIP Port field specifies the source port used for the first user
agent (UA) instance. Succeeding UAs get successive ports.

Set this field to Enabled for single-base systems.

Labels

Network

Src_Att Transfer 2nd call On Hold 1

\BX ML Tag Name
i@

Src_Att Transfer 2nd call On Hold n_

Example:

<Src_ Att Transfer 2nd call On Hold 1 >1</Src Att Transfer 2nd call On Hold 1 >

Web Parameter

Attended Transfer Behaviour

Default Value 1
Allowed Values  0: Disabled

* 1: Enabled
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Indicates if the second call is put on hold during an attended transfer.

Labels

Servers

Srv_Codec_Enable G729ab n

¥nBXML Tag Name
i

Srv_Codec_Enable G729%9ab n

Example:

<Srv_Codec_Enable G72%ab_1 >Disabled</Srv_Codec Enable G72%ab 1 >

Web Parameter

G729 Annex B

Default Value

Disabled
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Allowed Values * Enabled

* Disabled
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Indicates the use of G729 Annex B. If the value is Enabled, it uses G729 Annex B.

Labels

Servers

Srv_Enable_No_Sip_Registration_n_

¥BXML Tag Name
ifid

Srv_Enable No Sip Registration n_
Example:

<Srv_Enable No Sip Registration 1 >No</Srv Enable No Sip Registration 1 >

Web Parameter None
Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Defines if the base station should enable the SIP registration by default. If the value is set to No, it allows
the extension to register during SIP registration. If the value is set to ves, it doesn't allow the extension
to register during SIP registration.

You can still make and receive calls.

Labels None

Srv_Failback Before Failover n_

¥BX ML Tag Name
ifi®

Srv_Failback Before Failover n_

Example:

<Srv_Failback Before Failover 1 >yes</Srv_Failback Before Failover 1 >
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Web Parameter Failback before Failover

Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Options without units
User or Admin Exposed in admin level
Description Indicates failback to the primary server instead of failover to the next server.
Labels Server

Srv_Failback_de_register_n_

\BX ML Tag Name Srv_Failback de register n_
tfid

Example:

<Srv_Failback de register 1 >No</Srv_Failback de register 1 >

Web Parameter Deregister After Failback
Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Defines if the given extension should or shouldn't de-register at the previous server when failover

to the primary SIP server.
No: Don't de-register at the previous server

Yes: De-register at the previous server

Labels Servers
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Srv_Remote_Ringtone_n_

¥BXML Tag Name
itid

Srv_Remote Ringtone n_
Example:

<Srv_Remote Ringtone 1 >Enabled</Srv_Remote Ringtone 1 >

Web Parameter

Remote Ring Tone Control

Default Value Enabled
Allowed Values  Enabled
* Disabled
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Indicates to enable or disable the remote ringtone control (alert tone) sent to the handset.

Labels

Servers

Srv_Sip_Enable_Ptime_n_

¥nBXML Tag Name
ofid

Srv_Sip Enable Ptime n
Example:

<Srv_Sip Enable Ptime 1 >Enabled</Srv_Sip Enable Ptime 1 >

Web Parameter Use ptime
Default Value Enabled
Allowed Values * Enabled
* Disabled
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Indicates if the ptime and maxptime in the Session Description Protocol (SDP) is enabled or
disabled.
Labels Servers
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Srv_Sip_Enable_Rtcp_n_

¥BX ML Tag Name Srv_Sip Enable Rtcp n
i

Example:

<Srv_Sip Enable Rtcp_ 1 >Enabled</Srv_Sip_ Enable Rtcp 1 >

Web Parameter RTCP
Default Value Enabled
Allowed Values * Enabled
* Disabled
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Indicates the use of RTCP in SDP.
Labels Servers

Srv_Sip_Keep_Alive_n_

mﬁ(ML Tag Name Srv_Sip Keep Alive n
fid

Example:

<Srv_Sip Keep Alive 1 >Enabled</Srv_Sip Keep Alive 1 >

Web Parameter Keep Alive
Default Value Enabled
Allowed Values * Enabled
* Diabled
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Indicates to send the SIP keep alive packets. The keep alive packets keep the SIP channel

open and send the packets as SIP requests. If you define a proxy server address, these
packets are sent to this server. Otherwise, the packets are sent to the registered address.
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Labels Servers

Srv_Sip_Ringback_Tone_n_

anBX ML Tag Name Srv_Sip Ringback Tone n_
i

Example:

<Srv_Sip Ringback Tone 1 >Enabled</Srv_Sip Ringback Tone 1 >

Web Parameter Local Ring Back Tone
Default Value Enabled
Allowed Values * Enabled
* Disabled
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Indicates to use the ring back tone. If the value is Enabled, the handset generates the

ring tone locally.

Labels Servers

Srv_Sip_Rtp_Base_Equal_n_

\BX ML Tag Name Srv_Sip Rtp Base Equal n_
i@

Example:

<Srv_Sip Rtp Base Equal_ 1 >Disabled</Srv_Sip Rtp Base Equal_ 1 >

Web Parameter RTP from own base station
Default Value Disabled
Allowed Values * Enabled
* Disabled
Units Options without units
Limits Option
User or Admin Exposed in admin level
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Description

Indicates the base station which initiates the RTP traffic.

* Enabled—Starts the RTP Stream from the base station where the SIP registration
is sent.

* Disabled—Starts the RTP Stream from the base station where the handset is
currently present.

Labels

Servers

Srv_Sip_Server_Alias_n_

\BX ML Tag Name
i@

Srv_Sip Server Alias n_
Example:

<Srv_Sip_ Server Alias_1 >testservr</Srv_Sip Server Alias_1 >

Web Parameter Server Alias
Default Value None
Allowed Values String
Units String
Limits 10 characters

User or Admin

Exposed in admin level

Description

Identifies the short name for the call control server.

Labels

Servers

Srv_Sip_Show_Ext_Name_In_Hs_n_

¥BX ML Tag Name
i@

Srv_Sip_ Show_Ext Name In Hs n_

<Srv_Sip Show Ext Name In Hs 1 >Enabled</Srv_Sip Show Ext Name In Hs 1 >

‘Web Parameter

Show Extension on Handset Idle Screen

Default Value

Allowed Values

 Enabled
* Disabled
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Units

Options without units

Limits

Option

User or Admin

Exposed in admin level

Description

Indicates if the handset idle screen displays the extension.

Labels

Servers

Srv_Sip_Signal_Tcp_Port_n_

¥BX ML Tag Name
i@

Srv_Sip Signal Tcp Port n
Example:

<Srv_Sip Signal Tcp Port 1 >Enabled</Srv_Sip Signal Tcp Port 1 >

Web Parameter

Signal TCP Source Port

Default Value Enabled

Allowed Values  Enabled
 Disabled

Units Options without units

Limits Option

User or Admin

Exposed in admin level

Description Indicates to signal the source TCP port in the SIP messages when set to TCP or TLS.
You may need to change this parameter based on the given SIP PBX.
Labels Servers

Srv_SRTP Auth n_

¥BXML Tag Name
tfid

Srv_SRTP_Auth n_

Example:

<Srv_SRTP_Auth 1 >Disabled</Srv_SRTP_Auth 1 >

Web Parameter

Secure RTP

Default Value

Disabled
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Allowed Values « Enabled

* Disabled
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Indicates if the RTP streams are encrypted. If the value is set to Enabled, the

authentication is enabled in the SRTP stream.

Labels Servers

Static_IP

\tBX ML Tag Name Static IP
tfiB
Example:

<Static_TIP>192.168.10.25</Static_IP>

Web Parameter IP Address

Default Value None

Allowed Values IP address

Units IP address

Limits IP address

User or Admin Exposed in admin level

Description Indicates the IPv4 address of the device. You can change this value, if DHCP is disabled.
Labels Network

STUN_ Enable

¥BX ML Tag Name STUN_Enable
itiB
Example:

<STUN_Enable>No</STUN Enable>

Web Parameter Enable STUN

Default Value No
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Allowed Values * Yes

* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Indicates the use of RFC3489 Session Traversal UDP for NAT (STUN). If the value is
No, STUN is disabled.
Labels Network
STUN_Server
\tBX ML Tag Name STUN_Server
utiB
Example:

<STUN_Server>192.168.10.15</STUN_Server>

Web Parameter

STUN Server

Default Value None

Allowed Values IP address
Units IP address
Limits IP address

User or Admin

Exposed in admin level

Description

Identifies the location of the STUN server.

Labels

Network

Subcsr_Call_Group_Subscribed_

¥BXML Tag Name
itiB

Subcsr Call Group_ Subscribed

Example:

<Subcsr Call Group Subscribed >2</Subcsr Call Group Subscribed >

Web Parameter

Call Group(s)

Default Value

Fill(0x00000000)
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Allowed Values Integer

Units Integer

Limits 32bit (one bit per call group bytes) for one handset up to 1000 handsets
User or Admin Exposed in admin/user level

Description Indicates the call group ID.

Labels Terminal

Subscr Dect Ac _Code n

mML Tag Name Subscr Dect Ac Code n
ufid Where, n is the handset number.
Example:

<Subscr Dect Ac Code 1 >1111</Subscr Dect Ac Code 1 >

Web Parameter AC

Default Value FFFF

Allowed Values String

Units String

Limits 4 or 6 digits

User or Admin Exposed in admin level

Description Assigns individual access code to each handset.
Labels Extensions

Subscr_Dect_lpui_n_

¥BX ML Tag Name Subscr Dect Ipui n
it

Example:

<Subscr Dect Ipui 1 >O0xFFFFFFFFFF</Subscr Dect Ipui 1 >

Web Parameter IPEI
Default Value OxFFFFFFFFFF
Allowed Values Hexadecimal
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Units

Hexadecimal

Limits

None

User or Admin

Exposed in admin level

Description Identifies the International Portable Equipment Identity (IPEI) of the handset. The IPEI
isn't used with provisioning.
If you enable FEATURE IPEI CONTROLLED DECT REG, you can specify the handset IPEI
as HEX string that contains all 10 HEX values of the IPEI available on the handset
status menu.
The IPEI/IPUI value must be present only once in the configuration file.
When you register a handset to a base station, the entry to specify IPEI for the handset
should be open for registration.

Labels Terminal

Subscr Do Not_Disturb_Enabled n_

\BX ML Tag Name
i@

Subscr Do Not Disturb Enabled n_

Example:

<Subscr Do Not Disturb Enabled 1 >Disabled</Subscr Do Not Disturb Enabled 1 >

Web Parameter

Do Not Disturb

Default Value Disabled
Allowed Values * Enabled
* Disabled
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description Indicates if do not disturb option is enabled in the base station regardless of the setting in the
handset.
Labels Extensions > Add or Edit Extension

143



Subscr Hebu Password n_

¥BX ML Tag Name
il

Subscr_ Hebu Password n_

Where n is the handset index. The index can be 1-980 for 210 Multi-Cell Base Station
and 1-30 for 110 Single-Cell Base Station.

Example:

<Subscr_ Hebu Password 1 >Testpwdl@</Subscr_ Hebu Password 1 >

Web Parameter

HEBU Password

Default Value 0x254
Allowed Values String
Units String
Limits 40 characters

User or Admin

Exposed in admin level

Description

Indicates the password for the handset registration in the HEBU mode.

Labels

Terminal

Subscr Hebu Username n_

¥BX ML Tag Name
il

Subscr_ Hebu Username n_

Where n is the handset index. The index can be 1-980 for 210 Multi-Cell Base Station
and 1-20 for 110 Single-Cell Base Station.

Example:

<Subscr_Hebu Username 1 >Abcd</Subscr_ Hebu Username 1 >

‘Web Parameter

HEBU Username

Default Value None
Allowed Values String
Units String
Limits 40 characters

User or Admin

Exposed in admin level

Description

Indicates the username for the handset registration in HEBU mode.

Labels

Terminal
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Subscr Hide Number Enabled n_

¥BX ML Tag Name
il

Subscr_Hide Number Enabled n_

Example:

<Subscr Hide Number Enabled 1 >Disabled</Subscr Hide Number Enabled 1 >

Web Parameter Hide Number
Default Value Disabled
Allowed Values * Enabled

* Disabled
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Indicates that the base station hides the number regardless of the setting in the handset.

Labels

Extensions > Add or Edit Extension

Subscr_Intercom_Enabled _

¥BXML Tag Name
i@

Subscr_ Intercom Enabled
Example:

<Subscr Intercom Enabled >Disabled</Subscr Intercom Enabled >

Web Parameter Intercom
Default Value Disabled
Allowed Values * Enabled
* Disabled
Units Options without units
Limits Options without units

User or Admin

Exposed in admin/user level

Description

Indicates if the intercom is enabled for the handsets.

Labels

Terminal
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Subscr_Sip_Hs_ldx_n_

¥BX ML Tag Name Subscr Sip Hs Idx n_
ufid Example:

<Subscr Dect Ipui 1 >0x1231231234</Subscr Dect Ipui 1 >
<Subscr_ Sip Hs Idx 1 >1</Subscr_Sip Hs Idx 1 >

<User ID 1 >4081001000</User ID 1 >

<Subscr Dect Ipui 2 >0xXFFFFFFFFFF</Subscr Dect Ipui 2 >
<Subscr_ Sip Hs_ Idx 2 >1</Subscr_Sip Hs Idx 2 >

<User ID 2 >4081002000</User ID 2 >

Web Parameter ldx

Default Value n

Allowed Values Integer

Units Integer

Limits 1-1000

User or Admin Exposed in admin level

Description Handset ID association for an extension.
Labels Extensions

Subscr_Sip_Pincode_Dialout_n_

¥BX ML Tag Name Subscr Sip Pincode Dialout n
ofid

Example:

<Subscr_Sip_Pincode Dialout 1 >1234*</Subscr_Sip Pincode Dialout_ 1 >

Web Parameter None

Default Value None

Allowed Values Integer and special characters * and #

Units Integer and special characters * and #

Limits 0-8 digits

User or Admin Exposed in admin level

Description Indicates the pin code to use for outgoing call.
Labels None
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Subscr_Sip_Reject_Anonymous_Calls_Enabled_n_

¥BX ML Tag Name Subscr_Sip Reject Anonymous Calls Enabled n_

Gfid
Example:

<Subscr Sip Reject Anonymous_ Calls Enabled 1 >Disabled

</Subscr Sip Reject Anonymous Calls Enabled 1 >

Web Parameter Reject anonymous calls
Default Value Disabled
Allowed Values * Enabled
* Disabled
Units Options without units
Limits Option
User or Admin Exposed in admin level
Description Indicates if the handset should reject calls that don't have a caller ID.
Labels Extensions > Add or Edit Extension

Subscr_Sip_Ua_Use_Base_n_

¥BXML Tag Name Subscr Sip Ua Use Base n_
i

Example:

<Subscr Sip Ua Use Base 1 >0xFF</Subscr Sip Ua Use Base 1 >

Web Parameter None
Default Value 0xFF
Allowed Values * 0xFF: Not locked

* RPN value: Locked to a specific base

Units Hexadecimal
Limits 0-255
User or Admin Exposed in admin level
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Description Indicates that the account is locked to use one base station. The value 0xFF means Not
Locked.
Each base in a multicell system has an RPN value. This value is available on the Multicell
web page of the base station.

Labels None

Subscr Ua_

Data_Bw_Sca_Info_Mapping_n_

¥BX ML Tag Name
i

Subscr Ua Data Bw Sca Info Mapping n_
Example:

<Subscr Ua Data Bw Sca Info Mapping 1 >1, 1, 1, 1, 5, 5, 5,
5</Subscr_Ua_Data Bw_Sca Info Mapping 1 >

Web Parameter

Shared Call Appearance Settings

Default Value 65535, 65535, 65535, 65535, 65535, 65535, 65535, 65535

Allowed Values Integers entered 8 times separated by comma. Each integer can be 1-8 or 65535.
Units Integer

Limits 1-8 or 65535

User or Admin

Exposed in admin level

Description

Allows you to store the mapping of SCA information icons to extension IDs.

The extensions must be a part of a SCA. Each byte is one SCA information icon on the handset display. Byte
0 is the first icon from the left, byte 1 is the second icon, and so on. If byte is 0, an extension isn't mapped to
the corresponding icon. Several bytes that have the same value mean that the corresponding icons monitor
different call appearances on the same shared line.

Labels

Terminal

Subscr Ua_

Data_Emergency_Line_n_

¥nBXML Tag Name
i

Subscr Ua Data Emergency Line n

Example:

<Subscr Ua Data Emergency Line 1 >0xFFFF</Subscr Ua Data Emergency Line 1 >

Web Parameter Alarm Line
Default Value 0xFFFF
Allowed Values Hexadecimal
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Units

Hexadecimal

Limits

0-65535

User or Admin

Exposed in admin level

Description Indicates the index of the extension which dials the emergency number when you use the alarm
button on the handset.
Labels Terminal

Subscr_Ua_Data_Emergency_Profiles_n_

¥BX ML Tag Name
i@

Subscr Ua Data Emergency Profiles n

Example:

<Subscr Ua Data Emergency Profiles 1 >0x0</Subscr Ua Data Emergency Profiles 1 >

Web Parameter ProfileOto 7
Default Value 0x0

Allowed Values Hexadecimal
Units Hexadecimal
Limits 0-128 digits

User or Admin

Exposed in admin level

Description The bit map which contains the profiles that the handset uses. There is 1 bit for each profile 0-7. You
can only provision these values: 0, 1, 2, 4, 8, 16, 32, 64, 128.
Labels Terminal

Syslog_Server

\BX ML Tag Name
i@

Syslog Server

Example:

<Syslog Server>10.10.100.100:514</Syslog Server>

Web Parameter

Syslog Server IP Address

Default Value None
Allowed Values IP address
Units IP address
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Limits IP address

User or Admin Exposed in admin level
Description Indicates the address of the Syslog server.
Labels Management

Syslog_Transport

Xllﬁ(ML Tag Name Syslog Transport
(i

Example:

<Syslog Transport>0</Syslog Transport>

Web Parameter TLS security

Default Value 0

Allowed Values 0
o1

Units Options without units

Limits Option

User or Admin Exposed in admin level

Description Defines if syslog connection should use secure TLS during login.
* 0—Uses UDP

e 1—Uses TCP with TLS

Labels Management

Tcp_Keep_Alive_Interval

\BX ML Tag Name Tcp_Keep Alive Interval
ofid

Example:

<Tcp Keep Alive Interval>75</Tcp Keep Alive Interval>

Web Parameter TCP Keep Alive Interval
Default Value 75
Allowed Values Integer
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Units Seconds

Limits 0-4294967295
User or Admin Exposed in admin level
Description Identifies the length of time, in seconds, that the client waits before it sends a keep-alive

message on a TCP connection.

Labels Network

Text_Msg_Keep_Alive

mﬁ(ML Tag Name Text Msg Keep Alive
i@

Example:

<Text Msg Keep Alive>30</Text Msg Keep Alive>

Web Parameter Text Messaging Keep Alive (m)

Default Value 30

Allowed Values Integer

Units Minutes

Limits 0-65535

User or Admin Exposed in admin level

Description Indicates the frequency of keep alive messages in minutes.
Labels Management

Text_Msg_Mode

anBKML Tag Name Text_ Msg_Mode
i@

Example:

<Text Msg Mode>0</Text Msg Mode>

Web Parameter Text Messaging

Default Value 0

Allowed Values * 0: Disabled
* 1: Enabled

« 2: Enabled without Server
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Units

Options without units

Limits

Option

User or Admin

Exposed in admin level

Description Indicates if users can send text messages to other devices that support text messages.
+ 0: Disabled—Users can't send text messages.
* 1: Enabled—Users can send text messages to anyone. This requires the rest of the
fields in this area to be set.
« 2: Enabled without Server—Users can only send text messages to other members
of the system.
Labels Management
Text_Msg_Port
¥BXML Tag Name Text Msg Port
ufid Example:

<Text Msg_Port>1300</Text Msg_Port>

Web Parameter

Text Messaging Port

Default Value 1300
Allowed Values Integer
Units Integer
Limits 0-65535

User or Admin

Exposed in admin level

Description Indicates the Messaging and Alarm server port used for messages. Set the port to allow
users to exchange text messages with people outside your system. The value of this
field depends on the message server.

If you leave this field empty, users can only communicate inside the system.

Labels Management
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Text_Msg_Response_Time

¥BX ML Tag Name
il

Text Msg Response Time
Example:

<Text Msg Response Time>45</Text Msg Response_ Time>

Web Parameter

Text Messaging Response

Default Value 30
Allowed Values Integer
Units Seconds
Limits 0-255

User or Admin

Exposed in admin level

Description

Indicates the timeout if the system doesn't receive a response from the message server.

Labels

Management

Text_Msg_Server

¥BX ML Tag Name
il

Text Msg_ Server
Example:

<Text Msg Server>192.168.10.25</Text Msg_Server>

‘Web Parameter

Text Messaging & Alarm Server

Default Value None

Allowed Values IP address
Units IP address
Limits IP address

User or Admin

Exposed in admin level

Description Indicates the IP address or URL of the Messaging and Alarm server. Set the address to
allow users to exchange text messages with people outside your system.
If you leave this field empty, users can only communicate inside the system.

Labels Management
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Text_Msg_Ttl

XML Tag Name Text Msg Ttl
itid

Example:

<Text Msg Ttl>0</Text Msg Ttl>

Web Parameter Text Messaging TTL

Default Value 0

Allowed Values Integer

Units Seconds

Limits 0-65535

User or Admin Exposed in admin level

Description Indicates the text message time to live (TTL) in seconds. If set, the message only displays

for the configured amount of time. After that time, the message is automatically deleted.

The default value 0 means the message doesn't expire.

Labels Management

Third Preferred Codec n_

¥BX ML Tag Name Third Preferred Codec n_
i

Example:

<Third Preferred Codec_1 >G726</Third Preferred Codec 1 >

Web Parameter Codec Priority

Max number of codecs is 5

Default Value None

Allowed Values « PCMU
* PCMA
* G726
* G722
* G729
* OPUS

Units Options without units
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Limits Option

User or Admin Exposed in admin level

Description Identifies the code priority that base stations use for audio compression and transmission.
You can change the order of the codecs.

To get OPUS to display in the list, click Reset Codecs.

If you change the list in any way, you must press Reset Codecs on this page and Reboot
chain on the Multi cell page.

Labels Servers

Upgrade Rule (Base Station)

|t ML Tag Name Upgrade Rule
(i

Example:

<Upgrade Rule>http://server.com/ DBS-210-3PC-03-24-18-0000-58.fwu</Upgrade Rule>

Web Parameter Firmware Update Settings

Default Value None

Allowed Values URL

Units URL

Limits URL

User or Admin Exposed in admin level

Description Indicates the URL pointing to the base station firmware.
Labels Firmware Update

Upgrade Rule (Handset)

¥BX ML Tag Name Upgrade Rule HS
i

Example:

<Upgrade Rule HS>http://server.com/6825-RGD v0324 bl1708.fwu</Upgrade Rule HS>

Web Parameter Firmware Update Settings
Default Value None
Allowed Values URL
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Units URL

Limits URL
User or Admin Exposed in admin level
Description Indicates the URL that points to the handset firmware. This parameter can appear three times in the

configuration, each for 6823 handset, 6825 handset, and 6825 ruggedized handset.

Labels Firmware Update

Upgrade_Rule_RPT (Repeater)

Xllﬁ(ML Tag Name Upgrade Rule RPT
apd Example:

<Upgrade Rule RPT>http://server.com/RPT110-3PC-03-24-18-0000-58.fwu
</Upgrade_Rule RPT>

Web Parameter Firmware Update Settings

Default Value None

Allowed Values URL

Units URL

Limits URL

User or Admin Exposed in admin level

Description Indicates the URL points to the repeater firmware.
Labels Firmware Update

Use_One_Tcp_Conn_Per_Ext_n_

xtnBX ML Tag Name Use One Tcp Conn Per Ext n
it

Example:

<Use_One Tcp Conn Per Ext 1 >No</Use One Tcp Conn Per Ext 1 >

Web Parameter Use One TCP Connection per SIP Extension
Default Value No
Allowed Values * Yes

* No
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Units

Options without units

Limits

Option

User or Admin

Exposed in admin level

Description

Indicates the use of TCP or TLS connections.

When the SIP transport is TCP or TLS, there are two choices for the connections:
* Disabled—Each base station has a single TCP or TLS connection that the handsets share.
* Enabled—Each line has an individual TCP or TLS connection.

Note You should set this field to Enabled to handle multiple responses to a NAPTR or
SRV lookup.

Labels

Servers

Use_Pref Codec_Only n_

¥BX ML Tag Name
i

Use_Pref Codec_Only n_
Example:

<Use Pref Codec Only 1 >No</Use Pref Codec Only 1 >

Web Parameter

Use Own Codec Priority

Default Value No
Allowed Values * Yes
* No
Units Options without units
Limits Option

User or Admin

Exposed in admin level

Description

Indicates the codec priority for incoming calls.
* Disabled—Uses the calling party priority.

* Enabled—Uses the system codec priority.

For example, if enabled and the base has G722 as the top codec and the calling party
has Alaw on top and G722 further down the list, the G722 codec is chosen for the call.

Labels

Servers
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User ID n_

\BX ML Tag Name User ID n_
ofi®

Example:

<User_ID 1 >750</User_ID 1 >

Web Parameter Extension Info

Default Value N/A

Allowed Values String

Units String

Limits 35 characters

User or Admin Exposed in admin level
Description The handset extension information.
Labels Extensions

User Password

XML Tag Name User Password
i

Example:

<User_ Password>Testuserpwd4@</User_ Password>

Web Parameter User Password

Default Value String up to 8 characters

Allowed Values String

Units String

Limits 128 characters

User or Admin Exposed in admin level

Description Indicates the user password to access the web pages.
Labels Security
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VLAN_ID

\BX ML Tag Name VLAN_ID
il

Example:

<VLAN ID>0</VLAN ID>

Web Parameter ID

Default Value 0

Allowed Values Integer

Units Integer

Limits 0-4094

User or Admin Exposed in admin level
Description Identifies the 802.1Q VLAN.
Labels Network

Vian_ QoS

|t ML Tag Name Vlan_QoS
il

Example:

<Vlan QoS>0</Vlan QoS>

Web Parameter User Priority

Default Value 0

Allowed Values Integer

Units Integer

Limits 0-7

User or Admin Exposed in admin level

Description Defines the user priority. Use these values to prioritize different classes of traffic (voice,

video, data).
* 0—best effort
* 1—lowest priority

» 7—highest priority
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Labels Network

Voice_Mail_Number n_

XML Tag Name Voice Mail Number n_
i

Example:

<Voice Mail Number 1 >2177707717</Voice Mail Number 1 >

Web Parameter Mailbox Number

Default Value None

Allowed Values String

Units String

Limits 20 characters

User or Admin Exposed in admin level

Description Identifies the number for the handset to dial the voicemail system. This number should
be enabled on the SIP server. Leave the value empty if the number isn't used for voice
mail.

Labels Extensions > Add or Edit Extension

Voip_Sip_Auto_Upload

¥BXML Tag Name Voip Sip Auto Upload
apd Example:

<Voip Sip Auto Upload>Disabled</Voip Sip Auto Upload>

Web Parameter Upload of SIP Log
Default Value Disabled
Allowed Values * Enabled

* Disabled
Units Options without units
Limits Option
User or Admin Exposed in admin level
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Description Configures the automatic upload of SIP log files. If the value is Enabled, the SIP log
uploads to syslog server.
Labels Management

Web_Language

¥BX ML Tag Name
i

Web Language
Example:

<Web Language>English</Web Language>

Web Parameter

Select Language

Default Value

English

Allowed Values

List of languages
* English
* Espafiol
* Deutsch
* Francais
* [taliano
* Dutch
* Portugués
* Dansk
* Svenska
* Turkce
* Polski
* Russian
* Norsk
* Slovenian
* Cestina
* Hrvatski
* Srpski
* Magyar

Units

Options without units

161



Limits Option

User or Admin Exposed in admin and user level
Description Identifies the language for the base station web pages.
Labels Country

Web Min Pass Len

¥BX ML Tag Name Web Min Pass Len
tid

Example:

<Web_Min Pass_Len>12345678</Web_Min Pass_Len>

Web Parameter Minimum length (min 8)

Default Value 8 digits

Allowed Values Integer

Units Integer

Limits 4-127 digits

User or Admin Exposed in admin level

Description Defines the minimum password length to access the web pages.
Labels Security

Web Pass Constraint_To_ Ascii

B ML Tag Name Web Pass Constraint To Ascii
it

Example:

<Web Pass Constraint To Ascii>0</ Web Pass Constraint To Ascii>

Web Parameter Only ASCII characters
Default Value 0

Allowed Values Oorl

Units Options without units
Limits Option

User or Admin Exposed in admin level
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Description Indicates the use of characters in the password to access the web pages.

The value 1 allows to use only ASCII characters.

Labels Security

XSI| Host_Server

¥BX ML Tag Name XSI_Host Server
i

Example:

<XSI Host Server>192.168.11.102</XSI Host Server>

Web Parameter Server

Default Value None

Allowed Values IP Address

Units IP Address

Limits IP Address

User or Admin Exposed in admin level

Description Indicates the name or IP address (including the path) of a server to retrieve an XSI
server.

Labels Central Directory
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Revised: January 12, 2024

XML Tags for Handset Settings

This section provides information about XML tags used for handset settings.

Hs Admin_Pin_n_

\BX ML Tag Name Hs Admin Pin n_
apd Example:

<Hs Admin Pin 1 >1234</Hs Admin Pin 1 >

Default Value 0000
Allowed Values Integer
Units Integer
Limits 4 digits
Description Allows to change the admin PIN to unlock the handset.
Handset Menu Settings > Security > Change admin PIN
Hs Alarm n_
\BX ML Tag Name Hs_Alarm_n_
ufid Example:

<Hs_Alarm 1 >05:30</Hs_Alarm 1 >

Default Value Empty

Allowed Values hh:mm

Units Hour:minutes

Limits 00-23:00-59
Description Defines the alarm time.
Handset Menu Alarms > Alarm
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Hs Alert Tone n_

¥BX ML Tag Name Hs Alert Tone n
ufid Example:
<Hs Alert Tone 1 >1</Hs Alert Tone 1 >
Default Value 1
Allowed Values * 0: Ringer
* 1: Sunrise
* 2: Vibes
* 3: Reflections
* 4: Calculation
* 5: Loud ringer
Units Integer
Limits Options 1-5
Description Specifies the ring tone for alert calls.
Handset Menu Settings > Audio Settings > Alert tone

Hs Alert Vol n_

¥BXML Tag Name Hs Alert Vol n_
ufid Example:
<Hs Alert Vol 1 >1234</Hs Alert Vol 1 >
Default Value 3
Allowed Values 0-6
Units Integer
Limits 0-6
Description Specifies volume of the tone when you press Emergency button on the handset.
Note This setting isn't supported in 6823 Handset.
Handset Menu Settings > Audio settings > Alert volume
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Hs Auto Answer n_

¥BX ML Tag Name Hs_Auto Answer n_
ufid Example:
<Hs Auto Answer 1 >1234</Hs Auto Answer 1 >
Default Value 0
Allowed Values * 0: Normal
* 1: Any key
* 2: Automatic
Units Options without units
Limits Option
Description Defines the way the handset handles incoming calls
Handset Menu Settings > Auto answer

Hs_Auto_Keylock_n_

¥BXML Tag Name Hs_Auto Keylock n_
ufid Example:
<Hs_Auto Keylock 1 >On</Hs_ Auto Keylock 1 >
Default Value Off
Allowed Values *On
* Off
Units Options without units
Limits Option
Description Defines the handset to lock the keypad after the specified length of inactivity.
Handset Menu Settings > Security > Automatic keylock
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Hs Bluetooth n

¥BX ML Tag Name Hs Bluetooth n_
ufid Example:
<Hs Bluetooth 1 >On</Hs Bluetooth 1 >
Default Value Off
Allowed Values * On
« Off
Units Options without units
Limits Option
Description Allows to enable or disable the use of Bluetooth® headset.
Handset Menu Settings > Bluetooth > Enable/disable

Hs_Charger_Warn_n_

¥BXML Tag Name Hs Charger Warn n_
ufid Example:
<Hs_Charger Warn_ 1 >On</Hs_Charger Warn 1 >
Default Value On
Allowed Values * On
» Off
Units Options without units
Limits Option
Description Allows the handset to play a tone when you put the handset on the charger.
Handset Menu Settings > Audio settings > Charger warning
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Hs Confirm Sound n_

XML Tag Name Hs Confirm Sound n
ufid Example:
<Hs Confirm Sound 1 >On</Hs_Confirm Sound 1 >
Default Value On
Allowed Values * On
* Off
Units Options without units
Limits Option
Description Indicates to play a tone when you change a setting on the handset.
Handset Menu Settings > Audio Settings > Confirmation sound

Hs_Coverage_Warn_n_

¥BXML Tag Name Hs Coverage Warn n_
ufid Example:
<Hs_Coverage Warn 1 >0ff</Hs Coverage Warn 1 >
Default Value Off
Allowed Values *On
» Off
Units Options without units
Limits Option
Description Indicates the handset to give you a tone when the signal from the base station or repeater
becomes too weak.
Handset Menu Settings > Audio settings > Coverage warning
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Hs Hide Number n_

¥BX ML Tag Name Hs_Hide Number n_
ufid Example:
<Hs_Hide Number 1 >0</Hs Hide Number 1 >
Default Value 0
Allowed Values + 0: Off
* 1: On for next call
* 2: Always on
Units Options without units
Limits Option
Description Indicates if the handset can make a call without the Caller ID for the next call or for all
calls.
Handset Menu Settings > Hide Number

Hs Idle Clock n_

¥BXML Tag Name Hs_Idle Clock n_
ufid Example:
<Hs_Tdle Clock 1 >On</Hs Idle Clock 1 >
Default Value On
Allowed Values * Yes
* No
Units Options without units
Limits Option
Description Indicates if the time displays on the home screen when the handset is idle.
Handset Menu Settings > Idle Clock

169



Hs Idle Screen n_

¥BX ML Tag Name Hs Tdle Screen n_
ufid Example:
<Hs Idle Screen 1 >Off</Hs_Idle Screen 1 >
Default Value 0
Allowed Values + 0: Off
* 1: Idle clock (dimmed)
* 2: Startup image (dimmed)
Units Options without units
Limits Option
Description Indicates the screen display when the handset is in the charger.
Handset Menu Settings > Idle Screen Saver

Hs_Key Sound_n_

¥BXML Tag Name Hs Key Sound n_
ufid Example:
<Hs_Key Sound 1 >0</Hs Key Sound 1 >
Default Value 0
Allowed Values + 0: Silent
* 1: Click
* 2: Tone
Units Options without units
Limits Option
Description Indicates the sound you hear when you press a key on your handset.
Handset Menu Settings > Audio settings > Key sound
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Hs Led Green n_

¥BX ML Tag Name Hs Led Green n_
ufid Example:
<Hs Led Green 1 >2</Hs Led Green 1 >
Default Value 2
Allowed Values + 0: Off
* 1: Missed call
* 2: Voice message
* 3: Low battery
Units Options without units
Limits Option
Description Indicates the LED color at the top of the handset for the defined option.
Handset Menu Settings > LED signal > Green LED

Hs_Led_Orange_n_

¥BX ML Tag Name Hs Led Orange n_
ufid Example:
<Hs_ Led Orange 1 >3</Hs_Led Orange 1 >
Default Value 3
Allowed Values * 0: Off
* 1: Missed call
* 2: Voice message
* 3: Low battery
Units Options without units
Limits Option
Description Indicates the LED color at the top of the handset for the defined option.
Handset Menu Settings > LED signal > Orange LED
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Hs Led Red n_

¥BX ML Tag Name Hs Led Red n_
itid

Example:

<Hs Led Red 1 >1</Hs Led Red 1 >

Default Value 1
Allowed Values + 0: Off
* 1: Missed call
* 2: Voice message
* 3: Low battery
Units Options without units
Limits Option
Description Indicates the LED color at the top of the handset for the defined option.
Handset Menu Settings > LED signal > Red LED
Hs_Line_n_
¥BX ML Tag Name Hs_Line_n_
ufid Example:

<Hs Line 1 >65</Hs Line 1 >

Default Value 0

Allowed Values Integer

Units Integer

Limits 0-19

Description Indicates the primary line, if you have multiple lines.
Handset Menu Settings > Line
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Hs_Msg_Display_n_

¥BX ML Tag Name Hs Msg Display n_
ufid Example:
<Hs Msg Display 1 >On</Hs Msg Display 1 >
Default Value On
Allowed Values *On
« Off
Units Options without units
Limits Option
Description Defines the display of a new message when your handset is idle. When you receive a
new message, you can set the handset to:
« Display only that you have a new message.
* Display the full message immediately. This is the default setting.
Handset Menu Messaging > Settings > Display

Hs_Msg_Overwrite_0Old_n_

amBKML Tag Name Hs Msg Overwrite 0ld n_
ufid Example:
<Hs_Msg_Overwrite 0ld 1 >0ff</Hs_Msg Overwrite 0Old_ 1 >
Default Value Off
Allowed Values * On
* Off
Units Options without units
Limits Option
Description Indicates to overwrite old messages when the text message history reaches the limit.
You can keep up to 250 messages. If you don't enable the handset to overwrite old
messages, you have to manually delete messages when the text message history is full.
Handset Menu Messaging > Settings > Overwrite old
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Hs_Msg Send_n_

¥BX ML Tag Name Hs Msg Send n_
i

Example:

<Hs_Msg_Send 1 >On</Hs_Msg_Send 1 >

Default Value On
Allowed Values *On
* Off
Units Options without units
Limits Option
Description Indicates to save the messages you send in the text message history. By default, your

sent messages are saved in the text message history.

Handset Menu Messaging > Settings > Sent Messages
Hs Name n_

\BX ML Tag Name Hs_Name_n_

a8 Example:

<Hs_Name 1 >Handset9</Hs_Name 1 >

Default Value Empty

Allowed Values String

Units String

Limits 20 characters

Description Defines the name to display on the main screen of the handset.
Handset Menu Settings > Handset name

Hs Phone Lock n_

XML Tag Name Hs Phone Lock n
i

Example:

<Hs_Phone Lock 1 >0ff</Hs_Phone Lock 1 >
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Default Value Off

Allowed Values *On
* Off
Units Options without units
Limits Option
Description Allows to set up a PIN to unlock the handset.
Handset Menu Security > Phone lock

Hs Power Save n_

¥BXML Tag Name Hs_Power Save n_
upid Example:

<Hs_Power Save 1 >5</Hs_Power Save 1 >

Default Value 5

Allowed Values * 0: 5 seconds
* 1: 10 seconds
* 2: 20 seconds
* 3: 30 seconds
* 4: 45 seconds
* 5: 60 seconds

Units Options without units

Limits Option

Description Defines the time to turn off the handset screen.
Handset Menu Settings > Power save

Hs Ptt n_

\BX ML Tag Name Hs_Ptt_n_
i@

Example:

<Hs Ptt 1 >Off</Hs Ptt 1 >
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Default Value Off
Allowed Values *On
 Off
Units Options without units
Limits Option
Description Allows to use the handset as a two-way radio to talk with other active handsets in the
system.
Handset Menu Settings > Push to Talk

Hs Rec_ Alarm_Enable

¥BXML Tag Name Hs Rec Alarm Enable n_
ufid Example:
<Hs_Rec_Alarm Enable 1 >On</Hs Rec Alarm Enable 1 >
Default Value Off
Allowed Values * On
* Off
Units Options without units
Limits Option
Description Allows to set the alarm time for the defined days of the week.
Handset Menu Alarms > Recurrent alarm

Hs Rec Alarm n_

mﬁ(ML Tag Name Hs_Rec Alarm Enable n_
ufid Example:
<Hs Rec_ Alarm Enable 1 >12:45:1100101</Hs_Rec Alarm Enable 1 >
Default Value None
Allowed Values HH:MM

HH:MM:ddddddd, where, ddddddd is the day of the week
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Units Hour:minutes:day of the week
Limits 00-23:00-59
00-23:00-59:0000000-1111111
Description Indicates the time that your handset reminds you at a specific time each day with a
recurrent alarm timer. You can set only one recurrent alarm on the handset
Handset Menu Alarms > Recurrent alarm

Hs_Ring_Emerg_High_n_

¥BX ML Tag Name Hs Ring Emerg High n_
ufid Example:
<Hs Ring Emerg High 1 >5</Hs Ring Emerg High 1 >
Default Value 3
Allowed Values * 0: Ringer
* 1: Sunrise
* 2: Vibes
* 3: Reflections
* 4: Calculation
* 5: Loud ringer
Units Options without units
Limits Option
Description Defines the ring tone for high emergency calls.
Handset Menu Settings > Audio settings > Ring emerg. high

Hs_Ring_Emerg_Low_n_

\tBX ML Tag Name Hs_Ring_Emerg Low n_
apd Example:
<Hs Ring Emerg High 1 >2</Hs Ring Emerg High 1 >
Default Value 3
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Allowed Values * 0: Ringer
* 1: Sunrise
* 2: Vibes
* 3: Reflections
* 4: Calculation

* 5: Loud ringer

Units Options without units

Limits Option

Description Defines the ring tone for low emergency calls.
Handset Menu Settings > Audio settings > Ring emerg. low

Hs_Ring_Emerg_Mid_n_

¥BX ML Tag Name Hs Ring Emerg Mid n
apd Example:

<Hs_Ring Emerg Mid 1 >4</Hs Ring Emerg Mid 1 >

Default Value 3
Allowed Values * 0: Ringer
* 1: Sunrise
* 2: Vibes
* 3: Reflections
* 4: Calculation
* 5: Loud ringer
Units Options without units
Limits Option
Description Defines the ring tone for medium emergency calls.
Handset Menu Settings > Audio settings > Ring emerg. med

178



Hs_Ring_Mel_n_

¥BX ML Tag Name Hs Ring Mel n_
i

Example:

<Hs Ring Mel 1 >0</Hs Ring Mel 1 >

Default Value 0

Allowed Values * 0: Ringer
* 1: Sunrise
* 2: Vibes

« 3: Reflections
* 4: Calculation

* 5: Loud ringer

Units Options without units

Limits Option

Description Defines the ring tone for normal calls.
Handset Menu Settings > Audio settings > Ring melody

Hs_Ring_Norm_Msg_n_

¥BX ML Tag Name Hs Ring Norm Msg n_
i

Example:

<Hs Ring Norm Msg 1 >4</Hs Ring Norm Msg 1 >

Default Value 4

Allowed Values * 0: Ringer
* 1: Sunrise
* 2: Vibes

« 3: Reflections
* 4: Calculation

* 5: Loud ringer

Units Options without units
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Limits Option

Description Defines the ring tone for normal messages.

Handset Menu Settings > Audio settings > Ring normal msg.

Hs_Ring_Urgent_Msg_n_

mﬁ(ML Tag Name Hs Ring Urgent Msg n_
upid Example:

<Hs_Ring Urgent Msg 1 >4</Hs Ring Urgent Msg 1 >

Default Value 4
Allowed Values * 0: Ringer
* 1: Sunrise
* 2: Vibes
* 3: Reflections
* 4: Calculation
* 5: Loud ringer
Units Options without units
Limits Option
Description Defines the ring tone for urgent messages.
Handset Menu Settings > Audio settings > Ring urgent msg.

Hs_Ring_Vol_n_

amBKML Tag Name Hs Ring Vol n_
i@

Example:

<Hs_Ring Vol 1 >4</Hs_Ring Vol 1 >

Default Value 3
Allowed Values 0-6
Units Integer
Limits Integer
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Description Allows to change the volume of the ringer. This volume does not impact the volume
level when you are on a call.

Handset Menu Settings > Audio settings > Ring volume

Hs Select Network n

¥BX ML Tag Name Hs Select Network n_
ifi®

Example:

<Hs_Select Network 1 >72</Hs Select Network 1 >

Default Value 3

Allowed Values * 0: Auto select

* 1-20: Registration number in list

Units Options without units

Limits Option

Description Allows to select the network.
Handset Menu Connectivity > Select network

Hs_Silent_Charging_n_

Xt ML Tag Name Hs Silent Charging n_
i

Example:

<Hs Silent Charging 1 >0</Hs Silent Charging 1 >

Default Value 0
Allowed Values « 0: Off
* 1: Silent
Units Options without units
Limits Option
Description Allows to turn off the ringer if you don't want the handset to ring while it is charging.

Incoming calls continue to display on the screen.

Handset Menu Settings > Silent charging
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Hs Silent n_

¥BX ML Tag Name Hs Silent n
i

Example:

<Hs_Silent 1 >0ff</Hs_Silent_ 1 >

Default Value Off
Allowed Values *On
* Off
Units Options without units
Limits Option
Description Allows to stop the handset from ringing where there is an incoming call.

When the handset is in silent mode, incoming calls display on the screen, but the handset
does not play a ringtone.

Handset Menu Settings > Audio settings > Silent

Hs Unlock Pin n_

Xllﬁ(ML Tag Name Hs Unlock Pin n
i

Example:

<Hs_Unlock_Pin_1 >0000</Hs_Unlock Pin_ 1 >

Default Value 0000

Allowed Values Integer

Units Integer

Limits 4 digits

Description Indicates the PIN to unlock the handset..
Handset Menu None
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Hs Vibrate n_

¥BX ML Tag Name Hs Vibrate n_
itid

Example:

<Hs Vibrate 1 >0</Hs Vibrate 1 >

Default Value 0

Allowed Values + 0: Off
* 1: Vibrate then ring
* 2: Vibrate only

* 3: Vibrate and ring

Units Options without units
Limits Option
Description Sets the handset to vibrate mode when you have an incoming call.

This setting isn't available in 6823 Handset.

Handset Menu Settings > Audio settings > Vibrate
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